
Oracle Fusion
Cloud SCM

Using Shipping

23D



Oracle Fusion Cloud SCM
Using Shipping

23D

F85851-01

Copyright © 2011, 2023, Oracle and/or its affiliates.

Author: Divya Ramakrishna

This software and related documentation are provided under a license agreement containing restrictions on use and disclosure and are protected
by intellectual property laws. Except as expressly permitted in your license agreement or allowed by law, you may not use, copy, reproduce, translate,
broadcast, modify, license, transmit, distribute, exhibit, perform, publish, or display any part, in any form, or by any means. Reverse engineering,
disassembly, or decompilation of this software, unless required by law for interoperability, is prohibited.

The information contained herein is subject to change without notice and is not warranted to be error-free. If you find any errors, please report
them to us in writing.

If this is software, software documentation, data (as defined in the Federal Acquisition Regulation), or related documentation that is delivered to the
U.S. Government or anyone licensing it on behalf of the U.S. Government, then the following notice is applicable:

U.S. GOVERNMENT END USERS: Oracle programs (including any operating system, integrated software, any programs embedded, installed, or
activated on delivered hardware, and modifications of such programs) and Oracle computer documentation or other Oracle data delivered to or
accessed by U.S. Government end users are "commercial computer software," "commercial computer software documentation," or "limited rights
data" pursuant to the applicable Federal Acquisition Regulation and agency-specific supplemental regulations. As such, the use, reproduction,
duplication, release, display, disclosure, modification, preparation of derivative works, and/or adaptation of i) Oracle programs (including any
operating system, integrated software, any programs embedded, installed, or activated on delivered hardware, and modifications of such programs),
ii) Oracle computer documentation and/or iii) other Oracle data, is subject to the rights and limitations specified in the license contained in the
applicable contract. The terms governing the U.S. Government's use of Oracle cloud services are defined by the applicable contract for such services.
No other rights are granted to the U.S. Government.

This software or hardware is developed for general use in a variety of information management applications. It is not developed or intended for
use in any inherently dangerous applications, including applications that may create a risk of personal injury. If you use this software or hardware
in dangerous applications, then you shall be responsible to take all appropriate fail-safe, backup, redundancy, and other measures to ensure its safe
use. Oracle Corporation and its affiliates disclaim any liability for any damages caused by use of this software or hardware in dangerous applications.

Oracle®, Java, and MySQL are registered trademarks of Oracle and/or its affiliates. Other names may be trademarks of their respective owners.

Intel and Intel Inside are trademarks or registered trademarks of Intel Corporation. All SPARC trademarks are used under license and are trademarks
or registered trademarks of SPARC International, Inc. AMD, Epyc, and the AMD logo are trademarks or registered trademarks of Advanced Micro
Devices. UNIX is a registered trademark of The Open Group.

This software or hardware and documentation may provide access to or information about content, products, and services from third parties. Oracle
Corporation and its affiliates are not responsible for and expressly disclaim all warranties of any kind with respect to third-party content, products, and
services unless otherwise set forth in an applicable agreement between you and Oracle. Oracle Corporation and its affiliates will not be responsible
for any loss, costs, or damages incurred due to your access to or use of third-party content, products, or services, except as set forth in an applicable
agreement between you and Oracle.



Oracle Fusion Cloud SCM
Using Shipping

Contents

Get Help ................................................................................................................................  i

1 Overview 1
Overview of Tasks from the Inventory Management Work Area .........................................................................................   1

Inventory Management Work Area ............................................................................................................................................   6

High-Level Tasks and Roles for Shipping ................................................................................................................................   11

2 Manage and Release Pick Waves 13
Create Pick Wave ...........................................................................................................................................................................  13

Schedule Pick Wave .....................................................................................................................................................................   18

Manage Pick Slips .........................................................................................................................................................................  19

Confirm Pick Slips ........................................................................................................................................................................  20

Project-Specific Inventory ...........................................................................................................................................................   21

3 Process and Confirm Shipments 23
Manage Outbound Shipments ..................................................................................................................................................   23

Review Shipping Exceptions ......................................................................................................................................................   33

Manage Drop Shipments ...........................................................................................................................................................   34

Manage Quick Shipments ..........................................................................................................................................................   36

4 Execute Shipping Documents 39
Overview of Executing Shipping Documents ........................................................................................................................   39

Print Packing Slip Report ...........................................................................................................................................................   39

Print a Packing Slip Report as a Scheduled Process ............................................................................................................  39

Overview of Printing Shipping Documents for Configured Items ....................................................................................   40

Considerations for Printing Shipping Documents on RMAs ..............................................................................................  40

Considerations for Printing Shipping Documents on Return to Supplier Transactions ................................................   41

How Return to Supplier Transactions with Shipping Documents Are Processed ..........................................................   42

Apply Document Job Set Rules and Output Preferences ...................................................................................................   44

Attach Shipping Documents to Shipment .............................................................................................................................   44



Oracle Fusion Cloud SCM
Using Shipping

Generate Remit-to Number with Shipments for Argentina ................................................................................................  45

Generate Shipping Documents for Organizations in Portugal ..........................................................................................   45

FAQs for Execute Shipping Documents ..................................................................................................................................  49

Drop Ship Transactions ...............................................................................................................................................................   51

5 Manage Outside Processing Services 55
Overview of Outside Processing ...............................................................................................................................................  55

How Outside Processing Works With Shipping .....................................................................................................................  56

How Shipping Accepts Shipment Lines for Shipment to Suppliers for Outside Processing ........................................   57

Example of Confirming Shipment of Lines for a Work Order for Outside Processing ..................................................   58

FAQs for Manage Outside Processing Services ....................................................................................................................   59

6 Integrate with External Systems 61
Manually Interface Shipment Lines to External Systems ....................................................................................................   61

External System Shipping Integration Processes ..................................................................................................................   61

External System Shipping Integration Statuses ....................................................................................................................   62

Shipment Request Interface ......................................................................................................................................................   62

FAQs for External System Integration .....................................................................................................................................   63

7 Reserve Inventory 65
FAQs for Reservations and Picks ..............................................................................................................................................  65

8 Manage Brazil Outbound Shipments 67
Overview of Brazil Outbound Shipment Fiscal Documents ................................................................................................  67

Brazil Outbound Shipment Flow ...............................................................................................................................................  67

How You Manage Brazil Outbound Shipments .....................................................................................................................  69

Tax Authority Requirements in Brazil ......................................................................................................................................  70

Fiscal Document Transaction Types ........................................................................................................................................   72

Fiscal Document Shipping Statuses .........................................................................................................................................  72

Fiscal Document Duty Job Role for Shipping Users .............................................................................................................  72



Oracle Fusion Cloud SCM
Using Shipping

Get Help

Get Help
There are a number of ways to learn more about your product and interact with Oracle and other users.

Get Help in the Applications
Use help icons    to access help in the application. If you don't see any help icons on your page, click your user image
or name in the global header and select Show Help Icons.

Get Support
You can get support at My Oracle Support. For accessible support, visit Oracle Accessibility Learning and Support.

Get Training
Increase your knowledge of Oracle Cloud by taking courses at Oracle University.

Join Our Community
Use Cloud Customer Connect to get information from industry experts at Oracle and in the partner community. You
can join forums to connect with other customers, post questions, suggest ideas for product enhancements, and watch
events.

Learn About Accessibility
For information about Oracle's commitment to accessibility, visit the Oracle Accessibility Program. Videos included in
this guide are provided as a media alternative for text-based topics also available in this guide.

Share Your Feedback
We welcome your feedback about Oracle Applications user assistance. If you need clarification, find an error, or just
want to tell us what you found helpful, we'd like to hear from you.

You can email your feedback to oracle_fusion_applications_help_ww_grp@oracle.com.

Thanks for helping us improve our user assistance!

i

https://support.oracle.com/portal/
https://www.oracle.com/corporate/accessibility/learning-support.html#support-tab
https://www.oracle.com/education/
https://cloudcustomerconnect.oracle.com/pages/home
https://community.oracle.com/customerconnect/categories/idealab-guidelines
https://www.oracle.com/corporate/accessibility/
mailto:oracle_fusion_applications_help_ww_grp@oracle.com
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1  Overview

Overview of Tasks from the Inventory Management Work
Area  
Use the task panel on the Inventory Management work area to access your inventory, shipping, and receiving tasks.

Click Show Tasks in the task pane to toggle between these main categories:

• Inventory

• Counts

• Shipments

• Picks

• Receipts

Once you select a main category, you can view all the tasks in that category. Click a task link to open the UI pages for
that task.

Note:  The list of tasks that you can view and access depends on the products that your enterprise has licensed and
configured, and the security privileges and roles assigned to your user account.

Inventory
Inventory tasks include both inventory-related and consigned inventory-related tasks.

This table shows the Inventory tasks.

Task Description

Manage Item Quantities
 

Search, review, and maintain item quantities.
 

Create Miscellaneous Transaction
 

Create a miscellaneous inventory transaction.
 
A miscellaneous transaction is a transaction, such as a miscellaneous issue or miscellaneous receipt
that you can use to issue material.
 

Create Subinventory Transfer
 

Create inventory transfer transaction between two subinventories.
 

Create Interorganization Transfer
 

Create inventory transfer transaction between two organizations.
 

Create Project Transfer
 

Create an inventory transfer transaction between two projects.
 

Manage Reservations and Picks
 

Search, review, and maintain reservations and picks.
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Task Description

Create linkages between supply and demand sources by using reservations and picks.
 

Manage Movement Requests
 

Search, review, and maintain movement requests.
 
Movement requests are requests for the movement of material within an inventory organization.
 

Manage Transfer Orders
 

Search, review, and maintain transfer orders.
 
Transfer orders represent demand and supply in a single document.
 

Manage Pending Transactions
 

Search, review, and maintain pending inventory transactions.
 

Review Completed Transactions
 

Review completed inventory transaction details.
 

Manage Reservation Interface
 

Upload reservation data for processing.
 
Use the Reservation Interface to view, create, process, and delete inventory reservation requests in the
Oracle Fusion Cloud Inventory Management INV_RESERVATION_INTERFACE table.
 

Manage Lots
 

Search, review, and maintain lot information.
 

Manage Serial Numbers
 

Search, review, and maintain serial number information.
 

Confirm Pick Slips
 

Enter details of picked material and confirm a pick slip.
 

Manage Inventory Balance Messages in
Spreadsheet
 

Review and edit the pending or failed inventory balance messages from external systems.
 

Review Item Supply and Demand
 

Search for and review the supply and demand information for an item.
 

Review Replenishment Requests in
Spreadsheet
 

Review and update pending or failed inventory replenishment requests.
 

This table shows the Consigned Inventory tasks.

Task Description

Review Consumption Advices
 

Review inventory consumption advice details.
 

Manage Consigned Inventory Aging
 

Search, review, and maintain consigned inventory aging.
 

Review Consumption Advice Exceptions
 

Review inventory consumption advice exception details..
 

Create Transfer to Owned Transaction
 

Initiate an inventory transaction to transfer consigned inventory to owned inventory.
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Task Description

Transfers the ownership of the inventory from the supplier to the internal organization.
 

Create Transfer to Consigned Transaction
 

Initiate an inventory transaction to transfer owned inventory to consigned inventory.
 
Transfers ownership of the inventory from the internal organization to the supplier.
 

Use these guides to access content related to your inventory and consigned inventory tasks:

• Oracle Fusion Cloud SCM: Using Inventory Management

• Oracle Fusion Cloud SCM: Manufacturing and Supply Chain Materials Management

Counts
The Count tasks include both cycle counts and physical inventory.

This table shows the Cycle Count tasks.

Task Description

Create Cycle Counts
 

Create a count in which items are selected, counted, and reconciled with inventory records continually
throughout the year.
 

Manage Cycle Counts
 

Search, review, and maintain cycle count information.
 

Record Count Sequences
 

Enter the count quantity and recorded by for an individual item belonging to a cycle count.
 

Approve Count Sequences
 

Authorize an individual item count.
 

Review Count Interface Records
 

Review details of the count interface records.
 

This table shows the Physical Inventory tasks.

Task Description

Manage Physical Inventories
 

Search, review, and maintain physical inventories.
 

Record Physical Inventory Tags
 

Enter the count quantity for the physical inventory tags.
 

Approve Physical Inventory Adjustments
 

Authorize physical and financial inventory change.
 

Use these guides to access content related to your cycle count and physical inventory tasks:

• Oracle Fusion Cloud SCM: Using Inventory Management
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• Oracle Fusion Cloud SCM: Manufacturing and Supply Chain Materials Management

Shipments
This table shows the Shipments tasks.

Task Description

Manage Shipments
 

Search, review, pack, confirm and close shipments.
 

Manage Shipment Lines
 

Search, review, and maintain shipment lines.
 

Manage Shipment Message Interface
 

Review messages sent or received for a shipment or shipment line.
 

Create Pick Wave
 

Create a new pick wave.
 

Confirm Pick Slips
 

Enter details of picked material and confirm a pick slip.
 

Create Outbound Shipment Request
 

Publish an event with the necessary criteria to select and send shipment lines to the external system as
shipment requests.
 

Manage Shipping Transaction Corrections
in Spreadsheet
 

Review and edit the pending or unprocessed shipping transactions received through the open
interface.
 

Use the Oracle Fusion Cloud SCM: Manufacturing and Supply Chain Materials Management guide to access content
related to your shipment tasks.

Picks
This table shows the Picks tasks.

Task Description

Create Pick Wave
 

Create a new pick wave.
 

Confirm Pick Slips
 

Enter details of picked material and confirm a pick slip.
 

Schedule Pick Wave
 

Create pick waves on a regular basis adhering to set of release criteria.
 

Create Outbound Shipment Request
 

Publish an event with the necessary criteria to select and send shipment lines to the external system as
shipment requests.
 

Use these guides to access content related to your pick tasks:

• Oracle Fusion Cloud SCM: Using Inventory Management
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• Oracle Fusion Cloud SCM: Manufacturing and Supply Chain Materials Management

Receipts
The Receipts tasks include expected shipments, receipts, unordered receipts, and returns.

This table shows the Expected Shipments tasks.

Task Description

Receive Expected Shipments
 

Search, review, and select shipment lines to receive.
 

Manage Inbound Shipments
 

Search, review, and select inbound shipments to modify.
 

Create ASN
 

Maintain and communicate the advanced shipment notice.
 

Create ASBN
 

Maintain and communicate the advanced shipment and billing notice.
 

Upload ASN or ASBN
 

Upload advanced shipment notices and advanced shipment and billing notices.
 

This table shows the Receipts tasks.

Task Description

Inspect Receipts
 

Search, review, and select receipt lines to inspect.
 

Put Away Receipts
 

Search, review, and select receipt lines to put away.
 

Correct Receipts
 

Search, review, and select receipts to correct.
 

Review Receipts Interface
 

Review the receipt transactions interface.
 

Quality Inspection Results
 

Search, review, and select receipts to view quality inspection results.
 

This table shows the Unordered Receipts tasks.

Task Description

Create Unordered Receipt Lines
 

Create individual receipt transactions that identify the receipt of an unordered item without reference
to a purchase order.
 

Match Unordered Receipts
 

Search, review, and select receipt lines to match.
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This table shows the Returns tasks.

Task Description

Return Receipts
 

Search, review, and select receipt lines to return.
 

Manage Supplier Returns Without Receipt
 

Create, edit, delete, and cancel supplier returns without a receipt.
 

Use these guides to access content related to your receipts tasks:

• Oracle Fusion Cloud SCM: Using Receiving

• Oracle Fusion Cloud SCM: Manufacturing and Supply Chain Materials Management

Related Topics
• Oracle Fusion Cloud SCM: Using Inventory Management

• Oracle Fusion Cloud SCM: Using Receiving

• Oracle Fusion Cloud SCM: Manufacturing and Supply Chain Materials Management

Inventory Management Work Area  
Oracle Fusion Cloud Inventory Management offers a complete materials management solution that enables companies
to manage the flow of inbound and outbound material within the warehouse and stocking locations.

Oracle Fusion Cloud Inventory Management is comprised of products designed for specific warehouse management
business processes and tasks throughout the Inventory, Shipping, and Receiving applications. The Inventory
Management work area provides a landing pad for these applications.

You can use the Inventory Management work area to view high-level details of your warehouse operations through
infolets. Also, access tasks and processes to perform from the Task panel of the Inventory Management work area.

To use the Inventory Management work area, you must be aware of these items:

• Access

• Navigation

• Infolets

• Tasks

Access
Your access to the Inventory Management work area is determined by these factors:

• The products that your enterprise has licensed and configured

• The security privileges and roles assigned to your user account

These factors determine which infolets and tasks you can view and access.
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For more information about inventory, shipping, and receiving roles and privileges, refer to the Oracle Fusion Cloud
SCM: Security Reference for Manufacturing and Supply Chain Materials Management guide.

Navigation
To access the Inventory Management work area, click Navigator > Supply Chain Execution >  Inventory Management.

Infolets
Infolets are visual, actionable, and personalized information cards summarizing critical data about specific objects.
Infolet cards display in the Inventory Management work area to make key performance indicators easy to view,
understand, and act upon. Use the infolets in the Inventory Management work area to quickly view details about picks,
cycle counts, on-hand values, shipments, and receipts.

You can do the following with infolet cards:

• Flip or expand the card to view additional details about the object featured in the infolet card.

• Drill down to more details by navigating to relevant manage pages from the infolet view.

• Hide infolet cards.

• Reorder infolet cards.

Use the My Infolets icon in the right corner of the Inventory Management work area to toggle your infolets on and off.
Drag and drop infolets to rearrange them in the work area.

This table describes the infolets available on the Inventory Management work area, along with the page that you can
drill into by clicking details in the infolet.

Infolet Description Drill Down Page

Picks
 

View the number of open or confirmed picks.
Toggle to view open picks by pick slip type.
 

Confirm Pick Slips page
 

Late Cycle Counts
 

View the number of late cycle counts. Expand
the page to view individual late counts and drill
down to examine them.
 

Record Count Sequences page
 

Cycle Count Sequences
 

View cycle count sequences to approve and
record. Drill down to perform the cycle count
approval and recording tasks.
 

Manage Count Sequences page
 

On-Hand Value
 

Expand and drill into the Manage Items
Quantities page to view on-hand availability
details for items.
 

Note:
If you have access to multiple organizations
and the organizations have different
currencies, this infolet doesn't display
any data. Instead a message of No data
available displays.
 

Manage Item Quantities page
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Infolet Description Drill Down Page

Open Shipments by Priority
 

View the number of open shipments by priority
levels. Drill down to view shipment details.
 

Edit Shipments page
 

Open Shipments by Carrier
 

View the number of open shipments by top
carriers. Drill down to view shipment details.
 

Manage Shipments page
 

Shipment Lines
 

View shipment line statuses presented in a
circle graph:
 

• Awaiting pick release

• Awaiting pick confirm

• Backordered

• Awaiting ship confirm

Toggle to the next screen to see a summary
of shipment lines past due and the amount of
time that's past due for the shipment lines:
 

• 0 to 3 days

• 4 to 7 days

• 8 to 14 days

• 15 to 30 days

Click a shipment line status to drill down to the
Manage Shipment Lines page.
 

Manage Shipment Lines page
 

Shipment Exceptions
 

View the number of shipment exceptions and
drill down to view details of the shipment
exceptions.
 

Edit Shipment page
 

Shipment Lines for Next 30 Days
 

View shipment lines expected in the next 30
days presented in a bar graph based on time:
 

• 1 to 3 days

• 4 to 7 days

• 8 to 14 days

• 15 to 30 days

Drill down to view details of the expected
shipments.
 

Manage Shipment Lines page
 

Receipt Lines
 

View receipt line statuses:
 

• Awaiting receipt

• Awaiting put away

• Awaiting inspection

Drill down to the Receive Expected Shipments,
 Inspect Receipts page, and Put Away Receipts
page accordingly.
 

Receive Expected Shipments, Put Away
Receipts, and Inspect Receipts pages
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Infolet Description Drill Down Page

Toggle to view receipt lines that are past due
and broken down by time past due:
 

• 0 to 3 days

• 4 to 7 days

• 8 to 14 days

• 15 to 30 days

Note:  You can choose to display data for
30 days or 7 days using the Date Range for
Inventory Management Infolets profile
option for the Awaiting Receipt portion of the
infolet. The default setup is 7 days. You can
change this to 30 days if required.

Expected Receipt Lines
 

View expected receipt lines due in these time
ranges:
 

• 1 to 3 days

• 4 to 7 days

• 8 to 14 days

• 15 to 30 days

Drill down to view details of the expected
shipments.
 

Note:  You can choose to display data for
30 days or 7 days using the Date Range for
Inventory Management Infolets profile
option. The default setup is 7 days. You can
change this to 30 days if required.

Receive Expected Shipments page
 

Inspected Receipts
 

View the number of inspected and rejected
receipt lines. Drill down to view details of these
inspected receipts.
 

Manage All Lines page
 

Receipt Exceptions
 

View the number of receipt exceptions and drill
down to view details of the receipt exceptions.
 

Manage All Lines page
 

Backordered Supply Lines
 

View the number of backordered supply lines in
these statuses:
 

• Awaiting receipt

• Awaiting inspection

• Awaiting put away

Drill down to the Receive Expected Shipments,
 Inspect Receipts, and Put Away Receipts pages
accordingly to view details of the backordered
supply lines.
 

Receive Expected Shipments, Inspect Receipts,
 and Put Away Receipts pages
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Infolet Description Drill Down Page

Note:  You can choose to display data for
30 days or 7 days using the Date Range for
Inventory Management Infolets profile
option for the Awaiting Receipt portion of the
infolet. The default setup is 7 days. You can
change this to 30 days if required.

Inventory Transactions
 

View the number of internal inventory
transaction line records not yet processed or
in error. You can view these pending lines by
transaction type when data is available:
 

• Miscellaneous issue

• Miscellaneous receipt

• Account alias issue

• Subinventory transfer

• Interorganization transfer

• Cycle count adjustment

• User-defined transaction

• Receipt from

• Invalid (records without organization ID or
transaction type ID defined)

Note:
When the number of transaction types for
the pie chart goes beyond 9, the category
of Other displays to include transaction line
records for those categories that go beyond
9.
 

You can't drill into any transaction pages from
this infolet.
 

Note:
This infolet applies to integrations with third
parties, such as warehouse management
systems and third-party logistics companies.
 

Shipments and Receipts
 

View the number of external inventory
transaction line records not yet processed or
in error. You can view these pending lines by
transaction type when data is available:
 

• Receipt confirmation - pending

• Receipt confirmation - error

• Receipt advice

• Shipment confirmation - ready

• Shipment confirmation - error

• Shipping request

You can't drill into any transaction pages from
this infolet.
 

Note:
This infolet applies to integrations with third
parties, such as warehouse management
systems and third-party logistics companies.
 

Inventory Balances
 

View a summary number of inventory
reconciliation transaction records. This infolet is
especially important to keep inventory balances

You can't drill into any transaction pages from
this infolet.
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Infolet Description Drill Down Page

accurate between your system and the external
system.
 

Note:
This infolet applies to integrations with third
parties, such as warehouse management
systems and third-party logistics companies.
 

Note:  An infolet legend label may not appear if no data exists for that label. For example, for the Expected Receipt
Lines infolet, if all receipt lines are expected within the next 7 days, then only these labels display:

• 1 to 3 days

• 4 to 7 days

The labels for 8 to 14 days and 15-30 days don't appear in this example since all receipt lines are expected within the
next 7 days.

Note:  You can then hide the seeded infolets displayed on the landing page of the Inventory Management work area.
See How You Hide Inventory Management Infolets in the Implementing Manufacturing and Supply Chain Materials
Management guide.

Tasks
Use the task panel of the Inventory Management work area to access tasks and processes related to these areas:

• Inventory

• Counts

• Shipments

• Picks

• Receipts

Switch between these main areas by selecting Show Tasks in the Task pane.

Related Topics
• Overview of Tasks from the Inventory Management Work Area

• How You Use and Personalize Infolets in Oracle Fusion Cloud SCM and Procurement

• Overview of Infolets

High-Level Tasks and Roles for Shipping  
Here are the high-level tasks for roles in Oracle Shipping.

11
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Warehouse Manager
Warehouse manager tasks can include:

• Reserve inventory

• Manage pick waves

Warehouse Operator
Warehouse operator tasks can include:

• Pick loads

Shipping Agent
Shipping agent tasks can include:

• Process and confirm shipments

• Communicate with trading partners

• Capture shipping costs

For more information about shipping roles, duties, and privileges, refer to the Oracle Fusion Cloud Supply Chain
Management Security Reference for Manufacturing and Supply Chain Materials Management Guide.
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2  Manage and Release Pick Waves

Create Pick Wave  

Overview of Creating Pick Waves  
You can create a pick wave based on demand selection, fulfillment, and processing criteria. You can track pick waves in
the work area using the wave number and other details.

You can:

• Specify a release rule, or alternatively enter demand selection, fulfillment, and processing criteria

• Release the pick wave immediately

• Add the pick wave to the release schedule

To create a pick wave, select Navigator > Inventory Management, and then click the Create Pick Wave task from the
task panel.

Pick Waves  
A pick wave is a batch of shipment lines that are pick released together based on certain business-related criteria.

Examples of when you might want to use pick waves include:

• Fulfilling a particular customer demand

• Optimizing transportation

• Fulfilling backorders to reduce delay in shipment

Fulfill a Particular Customer Demand
If your organization has customers who have specific quality demands, then you can create a pick wave to perform extra
quality checks or follow special procedures during shipping.

Optimize Transportation
You can process a batch of shipment lines that are bound by common ship-to location, shipping method, and shipping
priority in order to optimize transportation. If your organization has several customers in one location, then your
organization can choose to collect all the shipment lines for those customers and ship them together through a
common carrier. For example, if an organization has 10 customers in location B, then it can collect all shipment lines for
location B and create a pick wave to ship them together using a common carrier, such as UPS truck service.

13
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Fulfill Backorders to Reduce Delay in Shipment
If your organization chooses to fulfill backorders by putting them on a faster shipping schedule, then you can create a
pick wave for all the backordered lines and ship them using a faster shipping method, such as Air.

Release Rules  
Release rules enable you to determine which order lines are considered for release and to select your processing criteria.
Selecting a release rule is efficient when you frequently use the same criteria to group order lines for release.

Release rules provide the flexibility to:

• Schedule pick waves using the Schedule Pick Wave process

• Specify multiple release criteria in a single step

• Select processing criteria

Schedule Pick Waves Using the Schedule Pick Wave Process
Release rules enable you to schedule creation of pick waves to release shipment lines using the Scheduled Pick Wave
page.

Specify Multiple Release Criteria
When you select a release rule, the criteria defined in the rule gets selected. This criteria determines which order lines to
consider and how to process them.

Select Processing Criteria
You can select and modify the processing criteria on the Options tab.

Considerations for Demand Selection  
Demand selection criteria impact the way lines are selected for picking.

Before selecting demand selection criteria, consider:

• Your organization's preferred criteria based on details pertaining to sales order, requested and scheduled dates,
and item

• Your organization's preferred criteria for order fulfillment and processing

Note:  Organizations can be selected using Ship From Organization field in Manage Pick Wave Release Rule only if
shipping parameters are setup for those organizations.

Sales Order, Requested and Scheduled Dates, and Item Details
Before selecting the sales order, requested and scheduled dates, and item details, you must plan how your organization
will create a pick wave.

• Which subinventory will you use?

14
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Your choice of subinventory will result in the selection of those order lines that are planned to be sourced from
the specified subinventory. The source subinventory is specified for the order lines during the sales order
creation stage.

• Which sales order will you select?

Determine if the shipment lines to be pick released are for a specific sales order.

• Which customer will you select?

Determine if the shipment lines to be pick released are for a specific customer.

• Which shipment set will you select?

If your organization groups order lines within a sales order to ship together based on customer specifications,
then those sets of lines are shipped together in the same shipment. You can select the appropriate shipment
set number from where the order lines will be selected.

• Which destination type will you select?

Determine if the shipment lines to be pick released are for a specific geography, zone, or ship-to location.

• What are the specified date ranges?

Determine the from and to scheduled ship dates and from and to requested ship dates.

• What item details will you specify?

Consider if you are creating a pick wave for a specific item. If yes, then specify the catalog and category name
along with the item name and description.

Shipping Details
The selected shipping method will enable selection of those order lines that are planned for shipping using the specified
shipping method.

Related Topics

Considerations for Pick Wave Options  
Options criteria impact the way lines are fulfilled and processed.

Before selecting the options criteria, consider:

• Fulfillment criteria

• Processing criteria
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Fulfillment Criteria
Before you select the fulfillment criteria, you must plan how your organization prefers lines to be fulfilled.

• What pick-from subinventory and pick-from locator will you specify?

Consider your organization's usage of a specific subinventory and locator to pick material from.

Note:  This is an optional criteria.

• What staging subinventory and locator will you specify?

Consider your organization's usage of a specific subinventory and locator to deposit the picked material for
staging.

Processing Criteria
Before you select the processing criteria, you must consider your organization's preference for processing lines.

• What release sequence rule will you specify?

Consider your organization's preference regarding the order in which lines are allocated during pick release.

• What pick slip grouping rule will you specify?

Consider your organization's preference regarding grouping of lines onto pick slips.

• What ship confirm rule will you specify?

Consider if your organization prefers shipments to be ship confirmed as part of pick release.

• Will you automatically confirm pick slips?

Consider if your organization prefers pick slips to be automatically confirmed during pick release.

• Will you create shipments?

Consider if your organization prefers shipments to be created during the pick release process.

• Which shipment creation criteria will you use?

Consider your organization's criteria for creating shipments--whether a shipment can be created across orders
or must be created from within an order.

• Will you automatically pack shipments?

Consider if your organization prefers shipments to be automatically packed.
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• Will you append existing shipments?

Consider if your organization prefers to append shipment lines to the existing shipments.

Note:  Here are the prerequisites for appending shipment lines:

◦ The appending limit must be defined as a value other than Do not append on the Manage
Shipping Parameters page.

◦ An organization must be specified.

◦ Create shipments functionality must be enabled.

◦ Shipment creation criteria must be defined as across orders.

◦ Autoconfirm pick slips functionality must be disabled.

Pick Release Logs  
Use the pick release logs to view details about your submitted pick wave process. These logs also give you a quick and
easy way to identify which lines were excluded from being released to your warehouse for picking and why they were
omitted.

The log messages are created when pick release is performed using the Schedule Pick Wave scheduled process or the
Release Pick Wave scheduled process (submitted by the Add to Release Schedule option on the Create Pick Wave
page).

You can find the log file as an attachment in the Process details section of the scheduled process:

1. From the Scheduled Process page, select your pick wave process.
2. Go to the Process Details section.
3. Under the Log and Output heading, click the link to open the Attachments window.
4. Click the file name to download the log output file.

The logs provide you with the following information:

• Pick release demand selection criteria

• Pick release processing parameters

• Pick release sequence

• Dynamic SQL statement used

• Overall count of the shipment lines that we excluded from selection with the reason those lines were excluded

In addition, you can also view the exact shipment line numbers that were excluded if you set the Enable Pick Release
Detailed profile option (ORA_WSH_PICK_RELEASE_ESS_DETAIL_LOGGING) to Y. This option is set to N by default.

FAQs for Creating Pick Waves  

What happens if I select prior reservations only?  
Only the lines or portions of lines that were previously reserved are considered for pick release.
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What happens if I include assigned lines?  
The shipment lines that are assigned to shipments are considered for inclusion during pick release.

What happens if I add a pick wave to a release schedule?  
You create the pick wave, however, the background process releases the lines.

You will receive the pick wave number and can proceed to perform the next task at hand.

Why doesn't the transfer order number, with a corresponding internal sales order,
display in the search criteria on the Create Pick Wave page?  
In a scenario where a sales order is created from a transfer order, the transfer order doesn't appear in the search criteria
of the Create Pick Wave page if any of its associated sales order lines are in a status of Not Started.

Schedule Pick Wave  

Overview of Scheduling Pick Waves  
You can schedule the creation of pick waves.

You can:

• Specify the release criteria for a pick wave

• Schedule how frequently you want pick waves to be created

• Specify whether the output should be printed, and determine the format and layout of the output

• Specify whether you want to be notified after a pick wave is created

To schedule pick waves, select Navigator > Inventory Management, and then click the Schedule Pick Wave task from
the task panel.

FAQs for Scheduling Pick Waves  

How can I schedule pick waves for release?  
Use the Schedule Pick Wave task to create and schedule pick waves to release shipment lines that meet certain criteria.

The shipment lines are released in a controlled mode and on a regular basis. Pick releasing of shipment lines that meet
criteria specified in the release rule is automated.
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Manage Pick Slips  

FAQs for Managing Pick Slips  

How can I record serial numbers that aren't in a range?  
Go to the Record Serial Numbers option in the Actions menu of the Confirm Pick Slips page to record serial numbers.

This takes you to the Record Serials page where you can select the Select Serial Numbers button to record multiple
serial numbers that aren't in a range. You can also select the Record Lots and Serial Numbers option in the Actions
menu of the Confirm Pick Slips page. This takes you to the Record Lots and Serials page where you can select the Select
Serial Numbers button to record multiple serial numbers that aren't in a range.

How can I record multiple lot and serial numbers?  
Go to the Record Lots and Serial Numbers option in the Actions menu to record multiple lots and serial numbers.

Note that you can record lots and serial numbers if the item is both lot and serial controlled.

What are the limitations on editing exceptions?  
An exception can be edited only on the Edit Pick page.

Click the Edit option from the Actions menu. However, you can only modify the exception reason and not create any
new exception.

How can I record more than one lot?  
Go to the Record Lots option in the Actions menu to record multiple lots.

Note that you can record lots if the item is lot controlled but not serial controlled.

How can I record serial numbers?  
Go to the Record Serial Numbers option in the Actions menu to only record serial numbers.

You can also go to Details to enter serial numbers. Note that you can record serial numbers if the item is serial controlled
but not lot controlled.

What is due date?  
A due date is a derived date based on whether a line is assigned or not.

The table shows how the due date is derived for picks.

Pick Shipment Due Date

1234
 

A
 

Shipment A exists for the pick 1234. Hence
the due date for the pick will be same as the
shipment's initial ship date
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Pick Shipment Due Date

1235
 

None
 
(shipment doesn't exist)
 

Shipment doesn't exist for pick 1235. Hence the
due date for the pick will be the same as the
shipment line's scheduled ship date.
 

What happens if I print pick slips immediately?  
When you choose to print pick slips immediately, you have to specify the number of pick slip lines per pick slip.

Whenever the specified number of lines are pick released, a pick slip document is printed. This continues till all the lines
that meet the release criteria are pick released and printed. For example, if you specify the number of pick slip lines as
25, then only a maximum of 25 pick slip lines can be printed on each pick slip. In this case, if 40 lines are pick released,
then two pick slips are printed; one with 25 lines and the other with 15 lines.

How can I view picks and pick slips for a specific date?  
Use the Release Date filter to view a list of pick waves that were generated on a specific date.

Use the Due Date filter on the Summary tab to view picks and pick slips due on a specific date.

Confirm Pick Slips  

Overview of Pick Slip Confirmation  
You use the Confirm Pick Slips page to enter details of picked material and confirm a pick slip.

You can do the following as part of confirming a pick slip:

• Enter details of picked material

• View and modify details of picks on a pick slip

• Enter multiple lot and serial number for picked material, if required

• Enter the transaction date for each pick

• Evaluate pick slip discrepancies

To confirm a pick slip, select Navigator > Supply Chain Execution > Inventory Management, and then click the
Confirm Pick Slips task from the task panel.

FAQs for Confirming Pick Slips  

What happens if I confirm a pick slip and navigate to ship confirm?  
You can continue with processing the shipment and then ship confirming it as an integrated flow.
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Can I add a secondary carrier to an Italian packing slip?  
Yes, you can add a secondary carrier to an Italian packing slip.

In the Additional Information column on the Management Shipments page or the Edit Shipment page in the Inventory
Management work area in the Manufacturing and Supply Chain Materials Management offering, select Packing Slip for
Italy for the regional information, and then enter a secondary carrier name.

Project-Specific Inventory  

How Project-Specific Inventory is Shipped  
You can ensure that inventories from a specific project are shipped against project-specific sales or transfer orders.

Also, when business rules allow, inventory from common inventory is shipped and the costs of the goods sold are sent
to the associated project.

You can validate the project attributes on each order line to make sure you send the correct combination of attribute
values to downstream applications, such as shipping and costing, regardless of whether you perform order capture in
the Order Management work area or through order import.

On the Manage Shipment Lines page, you can view the project record indicator, project, and task passed from Order
Management when it creates a shipping request. Pick release fulfills the reservation and allocates the material based on
the reservation.

During picking, you can do any of these:

• Pick release by project and task, and group the picks with the same project and task on a single pick slip.

• Override the suggested pick and pick any project or common inventory.

• Modify shipping reports to display the costing and inventory project, and task.

Pick Release by Project and Task
Here's how you can pick release by project and task:

1. From the Shipments task list in the Inventory Management work area, click Create Pick Wave.
2. Enter your Project Number and Task Number along with other criteria.
3. Click Release Now or Add to Release Schedule, depending on your needs.

Override Suggested Pick
Here's how you can override the suggestion and pick either project or common inventory:

1. From the Shipments task list in the Inventory Management work area, click Confirm Pick Slips.
2. On the Confirm Pick Slips: Search page, search for your pick slip.
3. Click the pick slip and change the inventory Project and Task attributes.
4. Select the Ready to Confirm check box. Then click Confirm and Close.
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3  Process and Confirm Shipments

Manage Outbound Shipments  

Shipments  
A shipment comprises a set of shipment lines, grouped by certain common shipping attributes, that are scheduled to be
shipped to a customer's ship-to location on a specific date and time.

You can include items from different sales orders in a shipment. You can either manually or automatically group
shipment lines to create a shipment. The shipment lines are grouped by the mandatory default criteria: ship-from
location and ship-to location. However, you may also include additional grouping criteria, such as customer, freight
terms, FOB (Free on board), and shipping method. A shipment can have the following three statuses:

• Open

• Confirmed

• Closed

Open Shipments
A shipment is open until it is confirmed.

Confirmed Shipments
A shipment is marked confirmed when it is ship confirmed, which means that all the lines in the shipment are loaded for
shipping to the customer's ship-to location.

Note:  A confirmed shipment may be reopened.

Closed Shipments
A shipment can be marked closed after it is confirmed. A closed shipment is the final stage the shipping process. A
closed shipment indicates that the inventory and the order have been updated to reflect the shipping of items from the
warehouse.

Note:  A closed shipment cannot be reopened.

E-Signatures for Approval
If shipping transactions are configured for approval using e-signatures, the E-Signature page opens when you click Ship
Confirm and close a shipment line. Use the page to approve the transaction.

The Electronic Signature IDs are recorded and available from the Manage Shipments and Edit Shipments pages.

For information about e-signatures, see the Oracle SCM Using E-Signatures and E-Records guide, available on the
Oracle Help Center.
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For information about how to configure e-signatures for supply chain management transactions, see the Oracle Fusion
Cloud SCM: Implementing Manufacturing and Supply Chain Materials Management guide on the Oracle Help Center.

Edit Shipments  
You can edit multiple shipments simultaneously, thereby optimizing time and cost.

When editing multiple shipments at once, consider how you will:

• Edit selected shipments

• Edit selected attributes

Edit Selected Shipments
You can edit only the shipments that you select to edit on the Manage Shipments page.

Edit Selected Attributes
You can edit only selected attributes for all the selected shipments. The updated value for the attribute will be the same
for all the selected shipments.

Pack Shipments  
Packing shipments is the process of packing items into packing units for shipping to the customer.

Packing shipments provides the flexibility to:

• Manually pack

• Automatically pack

Pack Shipments Manually
You can pack shipment lines manually by creating packing units and specifying the lines that are packed in each of the
packing units. Packing can be done for items as well as packing units. You can pack items into a packing unit and pack
those packing units into another packing unit. For example, you can pack items into a box and many boxes onto a pallet.

Here's how you pack shipments manually:

1. From the Shipment work area, click the Manage Shipment Lines task.
2. Search for a shipment line and then click Actions > Pack.
3. In the Select and Pack dialog box, search for and select a Packing Unit and then click Create Packing Unit.
4. In the Create Packing Unit dialog box, select the Ship-from Organization, Packing Unit Type, and Name

Generation fields, and then click Save and Close.
5. In the Select and Pack dialog box, click Close.
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Pack Shipments Automatically
You can choose to automatically pack shipment lines into packing units by selecting the Automatically Pack option for
the specific lines. The selected shipment lines are grouped by shared attributes, such as the ship-to location, and are
then packed based on the preferred default packing configuration.

Note:  You can automatically pack a shipment that's open and has at least one shipment line assigned to it. You can
automatically pack shipments if packing configurations have been defined.

Here's how you pack shipments automatically:

1. From the Shipments work area, click the Manage Shipment Lines task.
2. Search for a shipment line and then click Actions > Pack Automatically.

Pack Shipments Report
Oracle Transactional Business Intelligence lets you create ad hoc reports using real-time transactional data from Oracle
Fusion Cloud Inventory Management in order to monitor your materials management processes. The Packing Unit
dimension is available under the Shipment Line dimension of the Shipments Real Time subject area. The Packing Unit
dimension includes the following attributes for generating a report for your shipment lines:

• Packing Unit

• Description

• Weight UOM

• Maximum Load Weight

• Gross Weight

• Tare Weight

• Net Weight

• Maximum Volume

• Volume

• Volume UOM

• Percentage Filled

• Minimum Fill Percent

• Master Serial Number

• Seal Number

For more information, see these guides:

• Oracle Fusion Cloud Applications: Using Common Features

• Oracle Fusion Cloud SCM: Subject Areas for Transactional Business Intelligence in SCM

• Oracle Fusion Cloud SCM: Creating and Administering Analytics and Reports for SCM
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Return Material Authorization  
A return material authorization (RMA) is a return order your customers use to ship items back to your company to either
return the item for repair or to receive credit for the returned item.

When you receive a request from a customer to return goods, the order manager initiates an RMA order based on the
original customer order (the order status must be closed or partially closed). This initiation automatically creates an
RMA record in Oracle Receiving and a shipment in Oracle Shipping.

Taking on the role of the shipping manager, the order manager identifies the shipments that have been automatically
generated for the RMA order. The order manager generates and emails the packing slip and commercial invoice for the
shipment number to your customer. The customer can then send back the physical goods with the RMA paperwork to
your company.

When your company receives the returned items, the receiving agent creates a receiving advice for the RMA using the
RMA number referenced in the paperwork. A quality team inspects the returned items. If the items pass inspection,
the goods are sent back to the customer. If the items do not pass inspection, the returned items are slated for repair or
salvaged, and a credit memo is created and sent to the customer.

Note:  The inventory manager performs the put away for the RMA to the appropriate subinventory. Receipt
confirmation runs in the background to update order management about the RMA receipt, triggering the RMA order
lines status to change from Awaiting Receiving to Awaiting Billing.

Related Topics
• Order Types

Order Types  
Order types are used to classify transactions.

Shipping order types include:

• Sales order

• Transfer order

• Return transfer order

• Outside processing order

• Return to supplier order

• Drop ship order

• Return Material Authorization

Sales Order
A sales order is the orchestration document representing the demand and supply for items. Sales order lines can be
picked, packed, and shipped.

26



Oracle Fusion Cloud SCM
Using Shipping

Chapter 3
Process and Confirm Shipments

Transfer Order
A transfer order is the orchestration document representing the demand and supply for an internal material transfer.
Transfer order lines are similar to sales order lines. They can be picked, packed, and shipped.

Return Transfer Order
A return transfer order is a transfer order for which a return transaction is initiated. The return is performed against the
original transfer order. The price and tax for a return transfer order is derived in Oracle Receiving.

Outside Processing Order
An outside processing order is a work order where one or more operations of the work order are outsourced to a
supplier who provides specialized manufacturing services. Such work orders are created and released within the Oracle
Fusion Cloud Manufacturing solution.

Return to Supplier Order
A return to supplier order is a demand document for shipping items back to a supplier from a fully or partially received
purchase order to receive credit for the items. Return to supplier orders are generated as a result of a return transaction
initiated in Oracle Receiving.

Drop Ship Order
A drop ship order is one where material flows directly from a supplier or contract manufacturer to the customer. The
seller relies on the supplier or contract manufacturer to build, store, and ship product to the customer. A drop ship
purchase order is placed with a supplier, along with instructions that describe how to ship the items, and then the
supplier ships directly to the customer.

Return Material Authorization
A return material authorization (RMA) is a return order used by the customer to return items back to your company. The
return is performed against the original sales order. Use one of the following values as the return type for the RMA.

• Cancel the Item. Use this value to cancel an item that doesn't include a shipment. For example, a contract for
wireless phone service typically doesn't include a shipment, so your customer can't physically return it, but you
can cancel it.

• Return for Credit. Use this value for an item that your customer can't return for some reason or if your
customer didn't receive the shipment. For example, your customer received the item, but it's severely damaged.

• Return for Credit and Return Item. Use this value for an item that your customer must return. For example,
your customer received an incorrect item from the manufacturer and wants reimbursement. When the
manufacturer receives the returned item, the manufacturer issues a credit memo to the customer.

• Return for Repair: Use this value for an item your customer requests repair.

How Transfer Orders and Shipping Integration is Processed  
Transfer order processing is integrated with Oracle Shipping. You can pick, pack, and ship transfer order lines in
Shipping.
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You can also generate shipping documents for a transfer order.

Settings That Affect Transfer Order and Shipping Integration
Supply chain orchestration rules affect transfer order processing when integrating with shipping. These rules determine
if a transfer order is routed directly through Oracle Shipping, or through Oracle Fusion Cloud Order Management.
Shippable transfer order lines are interfaced to shipping directly from the transfer order pages in Oracle Fusion Cloud
Inventory Management.

How Transfer Orders Are Processed Through Shipping
Oracle Shipping plays a key role in transfer order processing. The following parameters are important components of
the transfer order and Shipping integration:

• Shipping can generate shipping documentation for transfer order lines.

• A transfer order line initially maps to one shipment line.

• Ship confirm updates the shipped quantity on transfer order lines.

• Shipping can accept a shipment line with internal locations for ship-to locations.

• Shipping validates the update of shipping-relevant attributes on transfer orders.

• Lines for return transfer orders are treated similar to the ones in the original transfer order, but are identified
separately with an order type of return transfer order.

• Transfer orders that do not require physical return of material are not interfaced to Shipping.

• Shipping can generate transfer order shipping cost records to pass to Costing.

How You Generate Shipping Costs for Transfer Orders  
The Generate Shipping Cost process generates shipping cost records for shipping costs tied to a transfer order
shipment.

Settings That Affect Generating Shipping Costs for Transfer Orders
Shipping cost records are generated for all transfer orders.

How Shipping Costs for Transfer Orders Are Processed
The Generate Shipping Cost process has the following requirements:

• Shipping costs at the shipment or container level are prorated down to the shipment line level so that
summaries are provided by shipment line.

Note:  This applies to shipment header and container level charges only.

• Prorating calculations are performed using the weight for the given shipment line.
If no weight was entered for the lines being prorated, then the quantity is used to drive the prorating
calculations.

Note:  This applies to shipment header and container level charges only.

28



Oracle Fusion Cloud SCM
Using Shipping

Chapter 3
Process and Confirm Shipments

• For shipping costs at the line level, the full charge associated with the delivery line is passed onto Costing.

Note:  This applies to delivery line level charges only.

• Records in the Shipping Costs table are summarized by shipment line and freight cost type.

• Shipping costs cannot be changed for transfer orders or return transfer orders after the shipment has been
confirmed and interfaced to Inventory.

• Costs in the shipping cost table are picked up when the associated transfer order shipment inventory
transaction is picked up by Costing.

How You Can Change Shipping Cost on Transfer Orders  
You can change transfer order shipping costs on the Record Shipping Costs page, whether or not the shipment or
shipment lines are open, confirmed, or closed.

However, for delivery lines associated with transfer orders, you can't make changes to the shipping costs after a
confirmed shipment is interfaced to inventory. You can still view shipping costs, but you can't update them.

Access the Record Shipping Costs page from the Manage Shipments and Manage Shipment Lines pages to view,
change, cancel, or record new shipping costs.

Oracle Shipping performs two validations on transfer order costs. They include:

• Protecting against duplicate freight costs

You can't add a new shipping charge when the same shipping charge is currently in the freight cost table
against the same delivery line.

• Disallowing changes after interfacing to Inventory

Shipping costs tied to a transfer order are passed to Oracle Fusion Cloud Inventory Management and onto
Oracle Costing. Once the confirmed shipment lines are interfaced to Oracle Inventory Management, Costing
is triggered to pick up these costs. You can't change shipping costs after confirmed shipping lines have been
interfaced to Oracle Inventory Management.

Note:  This restriction applies to delivery lines associated with transfer orders only.

FAQ for Transfer Orders  

What happens if I cancel a transfer order after a pick confirm without creating a
backorder?  
The material remains in the staging subinventory. You have to create a subinventory transfer or create a movement
request for the warehouse operator to relocate the material.
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FAQs for Managing Outbound Shipments  

What's the difference between inbound shipments and outbound shipments?  
Inbound shipments are items that you receive into the warehouse. Oracle Receiving supports the receipt of purchase
orders, purchase requisitions, return material authorizations, and interorganization shipments.

Outbound shipments are items that you ship out of the warehouse. Oracle Shipping automates and helps manage
outbound shipments.

Why can't I view shipment lines for a shippable item when the order has been
submitted and the orchestration plan shows that the ship task has started?  
You need to have the role of a warehouse manager for viewing or taking actions on shipment lines. This role is required
for every warehouse you work with.

How can I record shipping costs?  
Select the shipment for which you want to record costs and click Record Shipping Costs. You can create one or more
shipping cost records for shipments, items, or packing units in the Record Shipping Costs page.

How can I change ship options?  
Use the Change Ship Options option from the Actions menu to change the ship options for the selected shipment.

Why can't I change shipping costs on a transfer order?  
You cannot make updates to shipping costs after a transfer order shipment has been confirmed and interfaced
inventory.

How can I ship confirm a shipment?  
Select the shipment on the Manage Shipments page or the Edit Shipment page and select the Ship Confirm option.

However, you must select a ship confirm rule or specify ship confirm options, as well as resolve all error exceptions,
before you can ship confirm the selected shipment. You must also record lot and serial numbers for items that have that
requirement.

Note:  The actual ship date is always later than the pick transaction date of all lines in a shipment.

Can I ship confirm a shipment before resolving all exceptions?  
Yes. You can ship confirm a shipment without resolving information and warning exceptions. However, you cannot ship
confirm a shipment without resolving error exceptions.
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How can I review missing inventory controls for a shipment line?  
The Inventory Controls Missing column on the Edit Shipment page displays an alert icon when information is missing
for a shipment line.

You can hover over the icon to learn about what inventory control information is missing for the line. You can then
update the shipment lines to ensure that your shipment is confirmed without any issues.

What happens when the shipped quantity is between specified shipment tolerances? 

You have the option to consider a sales order fulfilled as soon as the quantity shipped is above the undershipment
tolerance, or when the quantity shipped falls between the ordered quantity and the overshipment tolerance.

How can I view the document job set applicable for the shipment?  
Select the shipment on the Manage Shipments page and click Review Document Job Set to view the document job set
applicable for the shipment.

How can I modify the document job set before ship confirm on a shipment?  
Select the Document Job Set value on the Change Ship Confirm Options page to apply the document job set for the
shipment on shipment confirmation.

What's a return to supplier transaction?  
A transaction that you use to return items to a supplier and receive credit for the items without interacting directly with
the supplier.

The return is routed through the organization to the outsourced manufacturer or supplier. The organization sends the
items back to the supplier.

What's a noninventory shipment?  
A shipment transaction created in Closed status for material that's not physically delivered into inventory in the
warehouse.

Noninventory shipments are used for return to supplier transactions to print shipping documents for the supplier and
send advance shipment notices (ASNs) to the customer. The shipping process for return to supplier transactions doesn't
generate inventory transactions or affect on-hand balances.

What are tax determinants?  
Explicitly or implicitly available details on transactions such as receipt, ship confirm, and consumption that become
inputs into the tax determination process. The tax determination process calculates the applicable taxes on the
transaction.

Examples of tax determinants are Taxation County, Product Fiscal Control, and Tax Classification Code.
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Why can't I edit the tax determinants?  
You must provide a value for the Taxation Country attribute before you can edit the following fields:

• Transaction Business Category

• Document Fiscal Classification

• User-Defined Fiscal Classification

• Product Fiscal Classification

• Intended Use

• Product Category

Also, some shipment and receiving lines don't show tax determinants due to their line status.

How can I process pending inbound shipment confirmations or errors?  
For inbound shipment confirmations whose interface status is ready, but which may not have been processed or which
may have errors, click Manage Shipping Transaction Corrections in Spreadsheet from the Shipments task list in the
Inventory Management work area.

Then you can edit the errors and upload the data. To do this task you need a spreadsheet add-in. From the Navigator,
click Download Desktop Integration Installer, to install the add-in.

Note:  The Manage Shipping Transaction Corrections spreadsheet displays only one error at a time for each sheet
even if the shipment processing has more than one error.

How can I process pending outbound shipping requests?  
To check which lines are in Ready to Interface integration status for pending outbound shipping requests, you can click
Manage Shipment Lines from the Shipments task list in the Inventory Management work area.

Then click the Create Outbound Shipment Request task to interface the transactions.

What happens if consolidate backordered lines?  
When you choose to consolidate backordered lines, any line that was split and subsequently backordered will be
automatically consolidated with other backordered lines that it was part of originally.

When a backorder occurs, Oracle Shipping searches for existing shipment line backorders for the particular line. If a
qualified existing backorder is found, then the current backordered shipment line is consolidated with the existing
backordered shipment line.

Note:  Only unassigned and unpacked backordered lines will be consolidated.

Can I view shipment summaries across all my organizations?  
Yes. You can select All Organizations to view summary of shipments and shipment lines for all the accessible
organizations.
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How can I find sales orders that contain project details?  
The Project Sales Order check box on the Manage Shipment Lines page indicates whether a sales order line contains
project details or not.

To see the project details of the sales order, go to the Inventory > Review Completed Transactions page after the
shipment line is shipped and interfaced to inventory.

Why are my order lines shipped separately instead of being shipped when all lines are
available for shipping?  
When Allow Partial Shipments of Lines is set to No in Oracle Fusion Cloud Order Management, the order lines are
prevented from being split.

But this doesn't prevent lines from being split during shipping. So, in Order Management, set Ship Lines Together to
Yes to ship all the order lines together when the order lines become available for shipping.

See the Shipment section of the Oracle Fusion Cloud SCM: Using Order Management guide for details.

Review Shipping Exceptions  

Overview of Shipping Exceptions  
A shipping exception is an unexpected event resulting out of a conflict between the requirements of the shipper,
customer, or transportation carrier.

Define and Maintain New Shipping Exceptions
You can define and maintain new exceptions. The exceptions can be of three types:

• Shipment: exceptions that are logged against shipments.

• Picking: exceptions that are logged during the picking process.

• Batch: exceptions logged to store the messages generated during the automated shipping processes such as
automatically pack and ship confirm.

You can inactivate a user-defined exception that's no longer in use by your organization. Disable the Active check box
on the Edit Shipping Exception page.

Note:  You can inactivate a user-defined exception only if the exception isn't currently in use by a shipment, shipment
line, or packing unit.

Modify Severity Levels of Exceptions
You can define and maintain the following severity levels of user-defined shipping exceptions:

• Error: Requires resolution before the transaction can be closed.

• Warning: Can be superseded and doesn't require resolution to close the transaction.
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• Information: Provides information on a particular transaction. The user isn't required to act on the information
exception to close the transaction.

Related Topics
• Predefined Exceptions

FAQs for Shipping Exceptions  

How can I resolve a shipping exception?  
Select and view details of the exception you want to resolve. Use the Closed option from the Status drop-down list and
save to resolve the exception. You may need to correct the cause of the error before closing the exception.

How can I log a shipping exception?  
Select Create Exception Record from the Actions menu to log an exception for a shipment or items within a shipment.

Manage Drop Shipments  

Overview of Drop Shipping  
Drop ship is an order fulfillment strategy where the seller does not keep products in inventory.

Instead, the seller relies on suppliers or contract manufacturers to build, store, and ship orders to customers. When
a customer places on order for a drop shipped product, the seller issues a purchase order for the item and provides
instructions for shipping directly to the customer. The supplier ships the product to the customer.

The following figure illustrates the drop ship process flow.

You can generate shipping documents for your drop ship orders. Shipments are automatically created when an advance
shipment notice (ASN) is created by the warehouse manager for the drop ship purchase order or by the supplier in the
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Supplier Portal. The shipping manager generates the packing slip, bill of lading, and commercial invoice as is applicable
to the shipment. The generated paperwork is sent to the supplier manually, typically through email. The supplier can
then ship the goods to the customer with the paperwork received from the seller.

Note:  The shipping paperwork for a drop ship order is similar to that of a regular sales order

Related Topics
• Promise Sales Orders in Your Drop Ship Flow

Promise Sales Orders in Your Drop Ship Flow  
Drop ship is a supply chain & manufacturing technique where the seller relies on a supplier or contract manufacturer to
build, store, and ship an item to your customer.

You can use Global Order Promising to help fulfill a drop shipment.

Here's what you need to do:

• Create the global sourcing rule that Promising will use to identify suppliers who can fulfill the drop ship, then
select one of them to do it. Specify the supplier calendar, supplier capacity, and supplier lead times.

• Create the assignment that Promising will use to assign the item to the sourcing rule that you just created.

• Go to one of the Supply Chain Planning work areas, then click Tasks > Maintain Supply Network Model. In the
Search Results area, click View > Columns, then display the Drop Ship Validation Organization attribute. Use
the Drop Ship Validation Organization attribute to create a validation organization for your drop shipment.

Get more:

• Learn what a drop shipment is and how the flow works. For details, see Overview of Drop Ship in Order
Management.

• Learn how Promising fits in the drop ship flow. For details, see How Drop Ship Works in Order Management.

• Learn how to set it up so it works with Order Management. For details, see Set Up Drop Ship in Order
Management.

Related Topics
• Promising Modes for ATP Rules

• Assign Your Sourcing Rules

• Source Your Supply Chain

• Assignments and Rules

FAQs for Manage Drop Shipments  

What's drop ship?  
Drop ship is an order fulfillment strategy where the seller does not keep products in inventory, but relies on suppliers to
build, store, and ship orders to customers.
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What's a drop ship purchase order?  
An order shipped from a supplier directly to the end customer, without the handling, stocking, or delivery of goods.

Can I print shipping documents for drop ship orders?  
Yes. The shipping manager can print the packing slip, bill of lading, and commercial invoice for drop shipments.

How can I send shipping instructions for drop ship orders?  
You can send shipping instructions manually to the supplier either with the shipping paperwork or by email. The
supplier, in turn, sends the paperwork to the customer.

How can I send an ASN for a drop ship order?  
A customer advance shipment notice (ASN) is created when the warehouse manager or supplier creates an ASN for a
drop ship order.

You can send this ASN to the customer using Integrated Cloud Service (ICS) integration or business to business (B2B)
messaging using Oracle Collaboration Messaging Framework, given the customer has enabled it.

ICS is an end-to-end integration orchestration platform that simplifies how to use and apply product integrations
offered within the cloud. Oracle Collaboration Messaging Framework provides the ability to manage business to
business (B2B) communications with large numbers of suppliers.

What's the difference between a purchase order return and a drop ship purchase
order return?  
For a regular purchase order return, you can return goods to either receiving or the supplier.

For a drop ship purchase order return, you can only return goods to the supplier. You can't return goods to receiving.

Manage Quick Shipments  

Quick Shipments  
For quicker shipment, you can skip pick release and pick confirmation and ship goods on transfer orders and sales
orders.

Perform a Quick Shipment
To perform a quick shipment:

1. In the Inventory Management work area, click Manage Shipment Lines from the Shipments Tasks panel.
2. On the Manage Shipment Lines page, search for a shipment line that is in the Ready to release, Backordered,

Not applicable, or Planned status.
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3. For the shipment line, enter values for inventory details such as Subinventory, Lot, and Serial. Use Record
Serial Numbers from the Actions menu to enter the serial number.

4. Save the shipment line. The Quick ship status appears as a check box in the shipment line details. The
shipment line is no longer available for pick release or to be sent to your warehouse management system, third-
party logistics provider, or contract manufacturer.

Note:  If you enter values incorrectly, select Reset Quick Ship Status from the Actions menu to reenter the
values.

5. Select one of the following from the Actions menu:

Stage Lines

Stage lines in a staging subinventory for packing, compliance screening, or carrier manifesting before you ship
confirm.

Ship Confirm

Shipment lines are automatically created, packed, and the shipment is closed.
6. Close the shipments manually or use the Enterprise Scheduled Process.
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4  Execute Shipping Documents

Overview of Executing Shipping Documents  
With Oracle Shipping, you can elect to generate and print shipping documents for customer orders.

The type of shipping documents is dependent on the specific customer order and purchase transaction. Types of
shipping documents include, but are not limited to:

• Advance shipment notice (ASN)

• Packing slip

• Bill of lading

• Commercial invoice

Related Topics
• Considerations for Printing Shipping Documents for Drop Ship Orders

• How Drop Ship Transactions with Shipping Documents Are Processed

Print Packing Slip Report  
When you ship goods, you can print a packing slip report to follow those goods.

The packing slip report lets you provide detailed information about a shipment to a customer, to another organization
as a transfer, or to a supplier as a return.

The packing slip report follows the goods during transportation and contains details about the contents of a particular
package, carton, pallet, or container for shipment. Before printing a packing slip report, you can define attributes
specific to your shipment, such as packing slip status, transportation reason, shipment description, and so on.

Related Topics
• Print a Packing Slip Report as a Scheduled Process

• Overview of Printing Shipping Documents for Configured Items

• Considerations for Printing Shipping Documents on Return to Supplier Transactions

• How Return to Supplier Transactions with Shipping Documents Are Processed

• View Output from Scheduled Processes

Print a Packing Slip Report as a Scheduled Process  
You can print a packing slip report for a shipment as a scheduled process.
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Perform these steps:

1. In the Navigator, select Scheduled Processes, and then click Schedule New Process.
2. In the Name field, click the down arrow, and then click Search.
3. In the Name field, enter Print Packing Slip Report, and then click Search.
4. In the search results, select Print Packing Slip Report from the drop-down list, click OK, and then click OK

again.
5. Select the process details specific to your shipment.
6. (Optional) To schedule the packing slip to print at a later date or frequency, click Advanced, and then click the

Schedule tab to enter the criteria.
7. Click Submit.

Related Topics
• Print Packing Slip Report

Overview of Printing Shipping Documents for
Configured Items  
You can print the details of the model and options selected for configured items on fulfillment documents.

This is known as the sales order view. The application calls a service at the time of shipment confirmation that provides
this information. You can view the details of the configured product on the packing slip and commercial invoice
throughout the receiving, inventory, and shipping processes. This helps avoid confusion when shipping configured
products because the contents of the shipment are indicated on the documents.

Note:  The quantities of the components contained in the configured item display on the documents in terms of a
single unit quantity. This means that the documents show the number of required components when the configured
item quantity equals one.

Related Topics
• Overview of Configure-to-Order

Considerations for Printing Shipping Documents on
RMAs  
You can select whether or not you want to print shipping documents for your customer returns.

To print shipping documents for RMAs (return material authorizations), select the Print shipping documents for
return material authorizations option on the Manage Receiving Parameters page.

To set access to the Manage Receiving Parameters page, in the Setup and Maintenance work area, use the Manage
Receiving Parameters task:

• Offering: Manufacturing and Supply Chain Materials Management
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• Functional Area: Receiving

• Task: Manage Receiving Parameters

Note:  The Print shipping documents for return material authorizations option is a onetime setup step for your
organization. You don't set this up per transaction.

Print Shipping Documents
If shipping documents are required, your organization may select the Print shipping documents for return material
authorizations option on the Manage Receiving Parameters page. For example, this can happen when your customer
returns an item through a RMA (return material authorization). The return transaction is then completed in two steps as
follows:

1. Creation of a shipment upon receipt of the RMA in Oracle Receiving.

Shipment lines are created for each item on the RMA order.
2. Confirmation of the shipment in Oracle Shipping upon put away of the receipt in Receiving.

This leads to the closure of the shipment. You can now generate shipping documents for the RMA order based
on the shipment number.

Not Printing Shipping Documents
If shipping documents aren't required, don't select the Print shipping documents for return material authorizations
option on the Manage Receiving Parameters page. Your customer return is completed in one step and you don't have to
confirm the shipment in Shipping.

Considerations for Printing Shipping Documents on
Return to Supplier Transactions  
You can select whether or not you want to print shipping documents for your return to supplier transactions.

To print shipping documents for these transactions, select the Print Shipping Documents for Returns to Suppliers
option on the Manage Receiving Parameters page.

To set access to the Manage Receiving Parameters page, in the Setup and Maintenance work area, use the Manage
Receiving Parameters task:

• Offering: Manufacturing and Supply Chain Materials Management

• Functional Area: Receiving

• Task: Manage Receiving Parameters

Note:  The Print Shipping Documents for Returns to Suppliers option is a one time setup step for your
organization. You don't set this up per transaction.
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Print Shipping Documents
If shipping documents are required, or if several people are involved in the process to ship the product back to the
supplier then your organization may select the Print Shipping Documents for Returns to Suppliers option on the
Manage Receiving Parameters page. For example, this can happen when your organization's customers return the
item to your organization, and then you must return the items to the supplier. This is a one time setup step for your
organization and it can't be changed for individual transactions. The return to supplier transaction is then completed in
two steps as follows:

1. Creation of the return to supplier transactions in Oracle Receiving.
2. Confirmation of the return to supplier shipment in Oracle Shipping. This leads to the closure of the shipment

and creation of the shipping documents.

Not Printing Shipping Documents
If shipping documents aren't required, don't select the Print Shipping Documents for Returns to Suppliers option on
the Manage Receiving Parameters page. Your return to supplier transaction is completed in one step and you don't have
to confirm the shipment in Shipping.

Related Topics
• How Return to Supplier Transactions with Shipping Documents Are Processed

How Return to Supplier Transactions with Shipping
Documents Are Processed  
When you need to return items to the supplier, you may choose to print shipping documents for transporting the
returned items back to the supplier.

Returns may be needed when a customer rejects an item from their received shipment, a defect is found internally, and
so forth. To print shipping documents for the return, follow the two-step return process that starts in Oracle Receiving
and continues through to Oracle Shipping.

Settings That Affect Return to Supplier Transactions
To print shipping documents for your return to supplier transactions select the Print Shipping Documents for Returns
to Suppliers option on the Manage Receiving Parameters page.

Note:  The Print Shipping Documents for Returns to Suppliers option is a one-time setup step for your
organization. You don't set this up per transaction.

Shipping documents print for return to supplier transactions when all of these conditions are true:

• The material is delivered (through put away receipts or direct receipt).

• The customer is returning to the supplier (and not returning to receiving).

• The goods are delivered to an inventory location (subinventory and locator) and not to an expense location.

If any of these conditions aren't satisfied, the print shipping documents aren't printed.
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How Return to Supplier Transactions Are Processed
Return to supplier transactions are processed in two steps:

1. Create the return to supplier transaction in Receiving.
The receiving agent has an offline interaction with the supplier to obtain the return material authorization
number for the return. Then, the receiving agent creates the return to supplier transaction by providing details
such as the returned quantity and return material authorization (RMA) number. Finally, the receiving agent
submits the transaction for processing and the transaction moves to Shipping.

2. Create and confirm the return to supplier shipments in Shipping.
Shipping treats the items on the return to supplier transaction as a noninventory shipment and stages the
items without creating a shipment. Noninventory shipments don't generate inventory transactions or affect on-
hand balances. Therefore, the application skips actions such as backorder, cycle count, pick release, and record
serials, since these actions aren't applicable to noninventory shipments. The shipping manager searches for
the return transactions, assigns the return to supplier lines to shipments, and performs ship confirm. Upon ship
confirm, Shipping generates the shipping documents for the customer, and creates and sends the automatic
shipment notices (ASNs) automatically to the supplier.

Corrections to Return to Supplier Transactions With Shipping Documents
You can make corrections to return to supplier transactions. The corrections are reflected on shipping documents up
until the returned products are shipped within the Shipping application. If you make corrections after the products are
shipped, the changes are still accepted in Receiving. Receiving maintains automated interfaces with Oracle Payables,
Oracle Cost Management, and Oracle Purchasing to share the corrected quantity information The table explains when
changes are allowed within the Shipping application based on the type of correction to the return to supplier transaction
and the associated shipment status.

Action Status of Shipment in Shipping Shipping Response

The return to supplier transaction sends an
update with an increase in quantity.
 

Shipped
 

An increase in the quantity is accepted at the
end of shipping and a new delivery line is
created.
 

The return to supplier transaction sends an
update with an increase in quantity.
 

Not shipped
 

Updates are accepted in Shipping.
 

The return to supplier transaction sends an
update with an increase in quantity.
 

Partially shipped
 

Updates are accepted in Shipping for the
unshipped lines. Updates for the lines already
shipped aren't accepted.
 

The return to supplier transaction sends an
update with a decrease in quantity.
 

Shipped
 

No updates are accepted in Shipping.
 

The return to supplier transaction sends an
update with a decrease in quantity.
 

Not shipped
 

Updates are accepted in Shipping.
 

The return to supplier transaction sends an
update with a decrease in quantity.
 

Partially shipped
 

Updates are accepted in Shipping for the
unshipped lines. Updates for the lines already
shipped aren't accepted.
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Action Status of Shipment in Shipping Shipping Response

The return to supplier transaction sends an
update that reduces the quantity to zero.
 

Shipped
 

No updates are accepted in Shipping.
 

The return to supplier transaction sends an
update that reduces the quantity to zero.
 

Not shipped
 

Shipping accepts the change, but setting
the quantity to zero cancels the shipment in
Shipping.
 

The return to supplier transaction sends an
update that reduces the quantity to zero.
 

Partially shipped
 

Updates are accepted in Shipping for the
unshipped lines. Other lines aren't accepted
because that part of shipment is canceled.
 

The return to supplier transaction makes
further updates after setting the quantity to
zero.
 

Canceled
 

You can't make further updates to a transaction
that's already canceled. You must create a new
return to supplier transaction.
 

Example
When your organization's customer initiates a return, they return the item to your organization. Your organization must
then send the items back to the outsourced manufacturer or supplier. Therefore, instead of your customers returning
the items directly to the suppliers, your customer's items are routed through your organization to your organization's
suppliers. In this instance, you must create shipping documents for transporting the items back to the suppliers.

Related Topics
• What's a noninventory shipment?

Apply Document Job Set Rules and Output Preferences  
The Apply Document Job Set Rules and Output Preferences scheduled process runs at the time of shipment
confirmation to identify the corresponding document job set applicable and the output preferences associated with the
shipment.

Based on the configured document job set rules and document job set preferences, the document job set is applied and
submitted as a scheduled process at the time of shipment confirmation.

You can run the Apply Document Job Set Rules and Output Preferences process manually to override the document job
set associated with the shipment.

Attach Shipping Documents to Shipment  
Use the Attach Shipping Documents to Shipment process to attach shipping documents to the shipments.
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When you select the Attach Document option on the Manage Shipping Document Output Preferences page, this
scheduled process runs at the time of shipment confirmation to attach the output of the corresponding job of the
document job set to the shipment as an attachment.

You can run the Attach Shipping Documents to Shipment process manually to attach output of the shipping reports to
the shipment.

Generate Remit-to Number with Shipments for
Argentina  
You can generate a remit-to number associated with a shipment for reporting to Argentinian regulatory authorities.

You need to ensure that Enable Document Numbering is selected for the Manage Localization System Option for the
Argentina Business Units in the Financials offering. Also ensure that the document sequence is set up by using the tasks
Manage Document Sequences and Manage Document Sequence Categories.

Generate Shipping Documents for Organizations in
Portugal  

Manage Shipping Requirements for Portugal  
All Portugal shipping documents must have this information.

• E-signature: All shipping documents: packing slips, bill of ladings, commercial invoices, and relevant tax
documents must have an e-signature, which is a way to authenticate, validate the document.

• Gapless document sequence: All shipping documents must have a unique, gapless, sequential number. This
sequence is used in generating the e-signature.

• QR code: The Portuguese tax authority requires all shipping documents include a two-dimensional QR code to
simplify invoices communication and monitor taxpayer transactions. QR code must be legible and present on
the last page of the shipping document. QR code is applicable for sales orders, transfer orders, return to vendor,
and outside processing shipments. This requirement affects organizations in Portugal. These organizations
must adapt their invoicing systems to the new government requirements.

• Unique Document Code (ATCUD): The Portuguese tax authority requires all shipping documents to include a
unique document code. ATCUD must be legible and present on all the pages of the shipping document. This
requirement affects organizations in Portugal.

• AT Doc Code ID: You can add the AT Doc Code ID to your shipments once you obtain it from the Portuguese tax
authority after ship confirmation.

Known Limitations
The limitations are:

• QR code amounts are represented in EUR currency.
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• Receipt transactions aren't supported.

Portugal Shipping Flow  
Here's a figure illustrating the Portugal shipping flow.

Explanation of callouts:

1. The Portugal shipment flow begins with the confirmation of a shipment.
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2. All Portugal documents must have an autogenerated e-signature, which is a unique value. The values for
creating an e-signature are confirm date, invoice number, gross amount, and previous signature. This e-
signature is available by associating these roles: ORA_WSH_PORTUGAL_SHIPMENT_PROCESSING_DUTY and
ORA_WSH_PORTUGAL_SHIPMENT_PROCESSING_DUTY_OBI. Assign users to the configured roles to enable
Portugal organizations with an e-signature.

Note:  You can enable e-signature by following these steps:
a. In the Setup and Maintenance work area, open the Tasks panel tab and search for Manage

Shipping Parameters.
b. On the Manage Shipping Parameters page, select the Autogenerate e-signature on shipping

documents check box.
c. Click Save and Close.

3. The system determines the job set rules and output preferences.
4. Generate and print shipping document using the job set and output preferences.

◦ The Job Set Oracle Enterprise Scheduler Service (ESS) job uses one of these options: Ship Confirm
Documents for Portugal in Training Mode or Ship Confirm Documents for Portugal in Production Mode.

◦ Four versions of the report are printed: Original, Duplicate, Triplicate, and Reprint. There's no difference
between the report versions, except for the header.

5. Attach the Reprint version of the generated shipping documents to the shipment.
6. Submit shipment to Inventory and Order Management.

Generate and Print a QR Code on Shipping Documents for
Organizations in Portugal  
To comply with changes in Portugal tax authority regulations, you must generate and print a unique QR code.

The QR code is printed at the bottom of all pages of the shipping documents: packing slips, bill of ladings, and
commercial invoices.

Note:  You can generate and print a QR code for use by organizations based in Portugal only.

You enable this feature on the Manage Standard Lookups page by taking these steps:

1. In the Setup and Maintenance work area, open the Tasks panel tab and search for Manage Standard Lookups.
2. On the Manage Standard Lookups page, search for the JE_ENABLE_FEATURE lookup type.
3. In the JE_ENABLE_FEATURE: Lookup Codes section, click Actions > New.
4. Create an entry for the PT_21B_OI_QR_CODE lookup code.
5. Click Save and Close.
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Generate and Print Unique Document Code on Shipping
Documents for Organizations in Portugal  
To comply with changes in Portugal tax authority regulations, you must generate and print a unique document code
(ATCUD).

ATCUD is printed on all pages of the shipping documents: packing slips, bill of ladings, and commercial invoices.

It is a concatenation of a validation code of the document series provided by the tax authority, and the sequence
number of the document within the series, which are separated by a hyphen. Once generated, it should be included in
the QR code.

Note:
1. You can generate and print ATCUD for use by organizations based in Portugal only.

Enable ATCUD Numbering  
In order to enable ATCUD on the Manage Shipping Parameters page, you must complete these steps:

Enable Regional Localization

1. Click Navigator > My Enterprise > Offerings.
2. On the Offerings page, select the Financials offering, and then click Opt In Features.
3. On the Opt In page, click the Edit Features icon for the Financials offering.
4. On the Edit Features page, search for Regional Localization, select the Enable checkbox, and select Portugal.
5. Click Save and Close.

Enable ATCUD Numbering for Portugal

1. Click Navigator > My Enterprise > Setup and Maintenance > Tasks > Search > Manage Localization System
Options.

2. On the Manage Localization System Options page, click the Create icon to add the business unit you want to
implement the ATCUD numbering in.

3. On the Localization System Options page, select the business unit and set the country to Portugal from the
Country drop-down list.

4. On the Localization System Options page, set the Enable ATCUD Numbering for Portugal option to Yes to
enable the configuration of ATCUD numbering using the Create Document Numbering spreadsheet.

5. Click Save and Close.

Set Up ATCUD Numbering
Download the Create Document Numbering spreadsheet to set up the ATCUD numbering.

1. Click Navigator > My Enterprise > Setup and Maintenance > Tasks > Search > Manage Localization
Document Numbering.

2. On the Manage Fiscal Document Sequences page, select Portugal in the Search For field.
3. Select the business unit on the Create Document Numbering in Spreadsheet window, then click OK to

download the spreadsheet.
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4. Once you open the spreadsheet, enter the Sequence Name, Prefix, Separator, Start Date, and End Date. Click
Upload to save the changes.

FAQs for Execute Shipping Documents  

How can I update a packing slip status?  
Ship confirm a shipment on the Manage Shipments page or on the Manage Shipment Lines page. By default, the
packing slip status value is the ship confirm rule associated with that shipment.

Alternatively, you can select the Change Ship Confirm Options action to change the packing slip status for a shipment.
Packing slip status values are:

• Final. The default value when the Close shipment check box is selected for the ship confirm.

• Draft. The default value when the Close shipment check box is not selected for the ship confirm.

If a shipment is not closed, you can also update a packing slip status when you print a packing slip report. Use the
scheduled process Print Packing Slip Report on the Scheduled Processes Overview page. You can print (or reprint)
immediately or schedule a future print date.

What's a return to supplier transaction?  
A transaction that you use to return items to a supplier and receive credit for the items without interacting directly with
the supplier.

The return is routed through the organization to the outsourced manufacturer or supplier. The organization sends the
items back to the supplier.

Can I print shipping documents for transfer order shipments?  
Yes, you can print the packing slip, pick slips, and bill of lading for transfer order shipments.

How can I print shipping instructions on shipping documents for
transfer order shipments?  
You can print shipping instructions on the packing slip and bill of lading for transfer order shipments by entering
instructions in the Notes to Supplier field on the Manage Transfer Order pages.
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How can I generate shipping documents at shipping confirmation?
 
You can generate shipping documents at shipment confirmation by defining the shipping document job set rules.

Alternatively, you can generate shipping documents at shipment confirmation by manually selecting the document job
set for a shipment by using the Change Ship Confirm Options action on the Edit Shipment page.

How can I view the document job set associated with a shipment?  
Once the shipment is confirmed, you can view the document job set associated with the shipment on the Manage
Shipments page in the Search Results.

The Document Job Set column shows the document job set that was applied for the shipment on shipment
confirmation. You can also view the ID of the document job set scheduled process applied for the shipment on shipment
confirmation in the Job Set Process ID column.

When do shipping documents print for return to supplier
transactions?  
Shipping documents print for return to supplier transactions when all of these conditions are true:

• The material is delivered (through put away receipts or direct receipt).

• The customer is returning to the supplier (and not returning to receiving).

• The goods are delivered to an inventory location (subinventory and locator) and not to an expense location.

• The Print Shipping Documents for Returns to Suppliers option is enabled for the organization on the
Manage Receiving Parameters page.

If any of these conditions aren't satisfied, the print shipping documents aren't printed.

Note:  The material needs to be in inventory. If material is returned before put away, no inventory is created. And,
if you're doing a return to receiving, then shipping documents aren't applicable because you aren't returning to a
supplier.
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Drop Ship Transactions  

Considerations for Printing Shipping Documents for Drop Ship
Orders  
You can select whether or not you want to print shipping documents for drop ship orders. To print shipping documents
for these transactions, select the Print shipping documents for drop ship orders option on the Manage Receiving
Parameters page.

In the Setup and Maintenance work area, use the following:

• Offering: Manufacturing and Supply Chain Materials Management

• Functional Area: Receiving

• Task: Manage Receiving Parameters

Note:  The Print shipping documents for drop ship orders option is a one-time setup step for your organization.
You don't set this up per transaction.

Print Shipping Documents
If shipping documents are required for your drop ship orders, then your organization selects the Print shipping
documents for drop ship orders option on the Manage Receiving Parameters page. For example, you might select this
option when the supplier for your organization creates an advance shipment notice (ASN) for the drop ship order. This
option is a one-time setup step for your organization and can't be changed for individual transactions. Complete the
drop ship order in two steps:

1. The supplier creates an ASN in the Supplier Portal. Alternatively, a warehouse manager can enter an ASN by
clicking the Create ASN task from the task panel of the Inventory Management work area.

2. The ASN creates a shipment in Closed status for the drop ship order. The shipping manager can print the
packing slip, bill of lading, and commercial invoice for drop shipments.

Note:  The shipping paperwork for a drop ship order is similar to that of a regular sales order.

Not Printing Shipping Documents
If shipping documents aren't required, don't select the Print documents for drop ship orders option on the Manage
Receiving Parameters page. Your drop ship order is completed in one step.

Related Topics
• How You Record the Shipment of Drop Ship Products to the Customer

• How You Use the AP Invoice Option for Drop Ship Purchase Orders

• Create an ASN on a Drop Ship Purchase Order
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How Drop Ship Transactions with Shipping Documents Are
Processed  
For customer orders for products that are not in inventory, you can use a supplier or contract manufacturer to build,
store, and ship the product to the customer.

This transaction is known as a drop shipment. A drop ship purchase order is issued to the supplier or contract
manufacturer, who in turn, ships the product to the customer.

For example, assume your customer places an order with you that requires a drop ship. The order manager sends a
purchase request to purchasing, which places a purchase order with your supplier, and then your supplier ships directly
to your customer. The drop ship purchase order, along with paperwork instructing how to ship directly to the customer,
is provided to the supplier. The supplier or contract manufacturer ships the item, and your company earns a profit.

You can generate shipping documents for drop ship orders. The shipment for a drop ship purchase order is
automatically created when the advance shipment notice (ASN) is created by the supplier on the Supplier Portal or by
the warehouse manager in the Inventory Management work area in the Manufacturing and Supply Chain Materials
Management offering. The shipping manager generates the packing slip, bill of lading, and commercial invoice for
the drop ship order for manual delivery to the supplier. The supplier then ships the goods to the customer with the
applicable paperwork.

The following figure illustrates the shipping document process flow for drop ship orders.

Settings That Affect Generation of Shipping Documents for Drop Ship Transactions
To print shipping documents for your drop ship transactions:

1. In the Setup and Maintenance work area, go to the following:

◦ Offering: Manufacturing and Supply Chain Materials Management

◦ Functional Area: Receiving

◦ Task: Manage Receiving Parameters

2. Select your organization.
3. On the Manage Receiving Parameters page, enable the Print shipping documents for drop ship orders

option.
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4. Click Save and Close.

Note:  The Print shipping documents for drop ship orders option is a one-time setup step for your organization.
You do not set this up per transaction.

Related Topics
• How Drop Ship Transactions with Shipping Documents Are Processed

FAQs for Drop Ship Transactions  

Can I print shipping documents for drop ship orders?  
Yes. The shipping manager can print the packing slip, bill of lading, and commercial invoice for drop shipments.

How can I send shipping instructions for drop ship orders?  
You can send shipping instructions manually to the supplier either with the shipping paperwork or by email. The
supplier, in turn, sends the paperwork to the customer.

How can I send an ASN for a drop ship order?  
A customer advance shipment notice (ASN) is created when the warehouse manager or supplier creates an ASN for a
drop ship order.

You can send this ASN to the customer using Integrated Cloud Service (ICS) integration or business to business (B2B)
messaging using Oracle Collaboration Messaging Framework, given the customer has enabled it.

ICS is an end-to-end integration orchestration platform that simplifies how to use and apply product integrations
offered within the cloud. Oracle Collaboration Messaging Framework provides the ability to manage business to
business (B2B) communications with large numbers of suppliers.
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5  Manage Outside Processing Services

Overview of Outside Processing  
Outside processing is a business process where one or more operations of a work order are outsourced to a supplier
who provides specialized manufacturing services.

These services may vary depending on the nature of the industry.

Outside processing is often adopted as a strategic alternative to in-house manufacturing for the following reasons:

• To lower manufacturing costs due to production costs

• To leverage state of the art manufacturing technology

• To increase capacity to overcome production bottlenecks

• To focus on core competencies

Here's a figure which explains a business flow where three operations are required to complete
a work order. Operation 10 which is machining, followed by operation 20 which is plating, and
operation 30 which is assembly. Operation 20 is a supplier operation performed by outside processing.

• An Original Equipment Manufacturer (OEM) performs the first operation in-house and ships the machined
parts to a supplier for plating.

• The supplier performs the plating operation and sends the plated parts to the Original Equipment
Manufacturer (OEM).

• The OEM receives the plated parts and pays the supplier for performing the value added services.

In the entire process, the OEM retains the ownership of the goods that are sent to and received back from the supplier.

Note:  The outside processing flow is supported for both discrete and process manufacturing.

55



Oracle Fusion Cloud SCM
Using Shipping

Chapter 5
Manage Outside Processing Services

How Outside Processing Works With Shipping  
In outside processing, one or more manufacturing operations in a work order are outsourced to external providers.

The Original Equipment Manufacturer (OEM) handles selective manufacturing operations in-house and outsources
other manufacturing operations to one or more service providers. Outside processing improves operational efficiency
by:

• Providing visibility into supply chain functions

• Reducing manual intervention

• Improving management of demand and supply side changes

• Providing better insight into outside processing costs

The outside processing flow begins and ends within the Oracle Manufacturing Cloud solution. Manufacturing sends
the shipment lines to Oracle Fusion Shipping for processing. From Shipping, the lines are packed and shipped to
the supplier. The supplier then performs their services on the goods and sends the goods back to the OEM. The
OEM receives the goods in Oracle Fusion Receiving and delivers the processed items to Manufacturing. For more
detailed information about the outside processing business process flow, see the Oracle Fusion Cloud SCM: Using
Manufacturing guide. For more information about outside processing in Receiving, see the Oracle Fusion Cloud SCM:
Using Receiving guide.

The following figure shows a high-level overview of the outside processing flow as it relates to shipping and receiving.
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Explanation of callouts:

1. Manufacturing sends shipment lines for outside processing to Shipping.
2. Shipment lines are imported into Shipping for packing and shipping to a supplier or manufacturing partner for

outside processing.
3. The supplier or manufacturing partner receives the items and performs the agreed upon outside processing

services.
4. After the supplier or manufacturing partner has completed service on the items, the items are sent back to the

original manufacturer.
5. Outside processing items are received back from the supplier or manufacturing partner in Receiving and

delivered to the original manufacturer to progress the work order to completion.
Throughout the entire process, the original manufacturer retains ownership of the goods that are sent to and received
back from the supplier or manufacturing partner. The work order and purchase order information follow all the steps of
the outside processing flow.

Note:  Manufacturing calls Oracle Fusion Supply Chain Orchestration to enable the shipping of partially finished
assemblies by creating shipment requests. The supply chain orchestration process tracks and monitors supply
orders for outsourced manufacturing operations. For more information about outside processing in Supply Chain
Orchestration, see the Oracle SCM Cloud Using Oracle Supply Chain Orchestration guide.

Use the Manage Shipment Lines page and the Edit Shipment Line  page to perform shipping-related tasks for outside
processing.

The job roles associated with outside processing in shipping are warehouse manager and shipping manager. Using
outside processing in Shipping, you can:

• Create shipments for shipment lines to a supplier

• Print shipping documents associated with the shipment, such as the packing slip and bill of lading

Integration with Oracle Global Trade Management Cloud is available for outside processing. However, integration with
Oracle Transportation Management Cloud isn't available for outside processing.

Related Topics
• Overview of Outside Processing

How Shipping Accepts Shipment Lines for Shipment to
Suppliers for Outside Processing  
The outside processing flow begins within the Oracle Fusion Cloud Manufacturing solution.

Oracle Fusion Cloud Manufacturing sends shipment lines to Oracle Shipping for processing by way of the supply chain
orchestration processes. For information about outside processing in Oracle Manufacturing, see the Oracle Fusion
Cloud SCM: Using Manufacturing guide. For information about the supply chain orchestration processes for outside
processing, see Oracle Fusion Cloud SCM: Using Supply Chain Orchestration guide.

Shipping accepts the work order, purchase order, and end assembly information and automatically sets the order type
for these shipment lines to outside processing. Work order information is stored in the order attributes, and purchase
order information is stored in the source order attributes. You can use these attributes to search shipment lines for

57



Oracle Fusion Cloud SCM
Using Shipping

Chapter 5
Manage Outside Processing Services

outside processing for a specific work order or purchase order throughout the entire shipping process. You can also
configure shipping documents to include these attributes, as well as end assembly details.

Because the goods are predefined in Manufacturing as outside processing and these shipment lines are not sales order-
related, Shipping creates these lines as staged directly. You can then pack and ship the shipment lines to the supplier for
outside processing.

Example of Confirming Shipment of Lines for a Work
Order for Outside Processing  
In this example, an operator in manufacturing generates a work order to manufacture an assembly item with multiple
operations, and one of the operations is a supplier operation.

The prerequisites before processing the work order are:

• Oracle Supply Chain Orchestration creates a purchase requisition for the required outside processing of the
work order's supplier operation.

• Oracle Purchasing approves the requisition and generates a standard purchase order for outside processing of
the partially finished assembly for the work order.

• The work order progresses to complete the first operation for the full quantity.

• Manufacturing calls on the supply chain orchestration process to enable the shipping of the partially finished
assembly by creating shipment requests. The supply chain orchestration process also communicates the
shipment request details, including the work order details and the purchase order details to Oracle Shipping.

• A shipping user confirms the shipment of the partially finished assembly to the outside processing supplier
within Shipping.

Confirm Shipment of Lines
To confirm shipment of lines for an outside processing work order, the warehouse manager:

1. Queries for shipment lines of the type outside processing on the Manage Shipment Lines page.

2. Records the shipping quantity and other shipping details on the Edit Shipment Lines page after reviewing the details
of the work order, purchase order, and end assembly for these shipment lines. This action triggers automatic creation
and assignment of the lines to a new shipment.

3. Queries the assigned shipment number on the Manage Shipments page and records the shipment details (such as
shipping method, waybill, freight terms, and so on), and then confirms the shipment.

Based on the default ship confirm options, the shipment is confirmed and closed at the same time. While closing the
shipment, an event is published for outside processing. The supply chain orchestration process listens to the event,
updates the supply order appropriately, and initiates the updates on the work order. The warehouse manager can now
query the work order within Manufacturing to verify the shipment and the shipped quantity details on the supplier
operation.

Note:  For consecutive supplier operations, goods move from one supplier to the next directly. The last supplier ships
the goods back to the original manufacturer.
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Confirm Shipment of Lines for Partial Quantities
In this example, the criteria is the same as the first scenario except that the warehouse manager splits the shipment
lines into two or more partial quantities. Each quantity is recorded and assigned to separate shipments, which the
warehouse manager must ship confirm and close.

FAQs for Manage Outside Processing Services  

Can I initiate corrections or returns for goods delivered from
outside processing suppliers?  
Yes. You must initiate corrections or returns for shipment lines for outside processing within the Oracle Fusion Cloud
Manufacturing solution.
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6  Integrate with External Systems

Manually Interface Shipment Lines to External Systems  
You can manually specify criteria to interface shipment lines to external systems. This enables you to reserve material
and send shipment requests while bypassing the regular processing steps.

Use the Create Outbound Shipment Request page (accessed from the Inventory Management work area) to specify the
criteria to interface shipment lines with an external system. To initiate the shipment request, select either a shipment
line or pick wave release rule, or enter a sales order.

Note:  You can use the Reservation Behavior for Integration to External Systems shipping parameter on the Manage
Shipping Parameters page in the Setup and Maintenance work area to send fully reserved shipment lines, partially
reserved shipment lines, or all shipment lines without checking material availability, as shipment requests to your
third-party logistics provider or warehouse management system. To send the shipment lines as shipment requests,
Shipping uses the Release Sequence Rule you set on the Create Outbound Shipment Request page (which you access
from the Inventory Management work area).

Generate a Shipment Request
Here's what you can do to publish an event for lines ready to be interfaced to an external system:

1. In the Navigator, click Tools > Scheduled Processes, and then click Schedule New Process.
2. In the Name field, select the down arrow, and then click Search.
3. In the Name field, enter Generate Shipment Request, and then click Search.
4. Select Generate Shipment Request and click OK.
5. In the Schedule New Process dialog box, click OK.
6. Select the Release Rule and click Submit.

Related Topics
• Considerations for Managing Shipping Parameters

• Release Shipment Requests to an External 3PL or WMS Using Release Sequence Rules

External System Shipping Integration Processes  
You can communicate requests to ship orders to execution partners.

Use the following processes to interface with external systems:

• Generate Shipment Requests

• Perform Shipping Transactions

• Confirm Shipment Process
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Generate Shipment Request
Use this process to schedule sending the shipment lines to external systems. This is a manual process to reserve
material and send shipment requests. This process skips the regular processing steps and handles regular
organizations, as well as those that are controlled by external systems.

Perform Shipping Transactions
This process handles the shipment confirmation interface records. It processes the pending transaction records
received into the open interface from both regular and externally controlled organizations.

The Perform Shipping Transactions process validates the data on the transaction records before processing them. It
records any errors from the validation step and leaves the transaction records in the open interfaces. You can view, edit,
resolve errors, and reprocess the interface records with errors.

Confirm Shipment Process
This process confirms the shipment, prints shipping documents, sends the shipment advice, and initiates the inventory
update process.

External System Shipping Integration Statuses  
Use external system shipping integration statuses to search for externally controlled shipment lines in a specific status.

These statuses are helpful when integrating with external systems, such as is the case when interfacing with contract
manufacturing.

External system shipping integration statuses available from the Inventory Management work area include:

• Lines ready to interface

• Interfaced lines awaiting ship confirm

• Lines with interface errors

External system shipping integration statuses available from the Edit Shipment, Edit Shipment Line, and Manage
Shipment pages include:

• Ready to interface

• Interfaced

• Confirmed

Note:  The integration status is not available by default. Select the integration status field from the View menu.

Shipment Request Interface  
The Shipment Request Interface enables you to view the error status of processed shipment lines.
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The Shipment Request Interface is a read-only interface and it depicts items which are currently processing or which
have an associated error. To reprocess a transaction which contains an error, you must rerun the transaction in the
transaction source system (for example, Oracle Fusion Distributed Order Orchestration).

Run the Shipment Request Interface by selecting the Manage Shipment Message Interface link from the Tasks pane
of the Shipments Overview page.

Before launching this interface, you must:

• Load import data to the Shipment Interface tables (WSH_TRANSACTIONS_HISTORY and
WSH_DEL_DETAILS_INTERFACE). For more information on each interface table, see Oracle Enterprise
Repository for Oracle Fusion Applications.

You can load data to interface tables using predefined templates and the Load Interface File for Import
scheduled process, which are both part of the External Data Integration Services for Oracle Cloud feature. For
other implementations, optionally use this feature only if you have SFTP configured for it.

• Establish parent-child relationships for the Shipment Interface tables (WSH_TRANSACTIONS_HISTORY and
WSH_DEL_DETAILS_INTERFACE).

FAQs for External System Integration  

How can I review and resolve interface record errors for shipment
transactions?  
Use the Manage Shipping Corrections in Spreadsheet task to manage pending transactions and transactions with
processing errors.

This task uses a spreadsheet interface to enable you to review and edit interface transactions and their corresponding
errors related to the shipping transactions received from external systems.

What's an execution partner?  
An external company that provides execution services like a logistics service provider or contract manufacturer.

Why do some shipment lines remain unprocessed?  
Setup data in third-party logistics or warehouse management applications can be incomplete or incorrect, which may
cause shipping requests from Oracle Fusion Cloud Inventory Management to remain unprocessed.
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How can I reprocess shipment lines that remain unprocessed?  
Search for the Interfaced integration status with other parameters on the Manage Shipment Lines page, select one or
more shipment lines, and reset their integration status to Ready to Interface.

Note:  Perform the search depending on the information from the third-party logistics or warehouse management
applications about resending the lines for processing.
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7  Reserve Inventory

FAQs for Reservations and Picks  

What's a reservation?  
A reservation links a supply source to a demand source and guarantees allotment of material to the demand source.

A supply source could be on-hand inventory or a purchase order. A demand source could be an account, cycle count,
or user-defined demand source. You can reserve material at the subinventory, locator, and if applicable, lot and serial
number level.

Why are reservations not completely deleted when I close a
partially completed work order?  
When a work order is partially completed, on-hand reservations aren't deleted. Closing a work order deletes only
existing reservations against the work order. If you want to delete the reservations you need to return the work order.

What's a pick?  
A pick is a manually- or automatically-created suggestion to honor a reservation when on-hand inventory is available.

Picks can be created for material at the subinventory, locator, lot, and serial number levels.

Why does a pick release fail for a sales order line in a back-to-back
flow?  
A pick release isn't processed if the ordered quantity isn't the same as the reservation quantity.

To process the pick release, you need to delete the back-to-back reservation and create a reservation manually.

What's a cycle count reservation?  
A cycle count reservation is a reservation with the demand document type of cycle count.
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You can create a cycle count reservation if, during picking or shipping, you have determined missing material and you
want to ensure that no one else tries to use or pick the missing material. Cycle count reservations are deleted when you
perform a cycle count of the item in the specified location.

What happens to reservations when I make changes to supply
sources?  
Reservations change according to supply sources.

The changed supply sources are:

• On hand: After on-hand supply has been issued against a specified demand, the on-hand quantity decreases
by the amount that was issued. The same material can't be issued against another demand.

• Purchase order: If you reduce the quantity of material in or cancel a purchase order that's reserved against a
demand, the corresponding reservation is modified or canceled.

Any other changes to the purchase order that affect the expected quantity also trigger changes to the
associated reservation.

• Requisition: If you reduce the quantity of material in or cancel a requisition that's reserved against a demand,
the corresponding reservation is modified or canceled.

Any other changes to the purchase order that affect the expected quantity also trigger changes to the
associated reservation.

• Transfer order: If you reduce the quantity of material in or cancel a transfer order that's reserved against a
demand, the corresponding reservation is modified or canceled.

Any other changes to the purchase order that affect the expected quantity also trigger changes to the
associated reservation.

• Transfer order return: If you cancel a transfer order return that's reserved against a demand, the corresponding
reservation is canceled.

• Work order: If you reduce the quantity of material in or cancel a work order that's reserved against a demand,
the corresponding reservation is modified or canceled.

Any other changes to the purchase order that affect the expected quantity also trigger changes to the
associated reservation.
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8  Manage Brazil Outbound Shipments

Overview of Brazil Outbound Shipment Fiscal
Documents  
The Brazilian fiscal government authority has implemented a requirement that a fiscal document (Nota Fiscal in
Portuguese) must accompany shipments to document trade between suppliers and customers.

The fiscal document serves as a bill of lading to detail the quantity of items transported from the supplier to the
customer (and in the case of reverse flows, from customers to suppliers). It also serves as a proxy invoice from the
supplier that documents the material costs, supplier charges, and taxes payable by the customer.

The Brazilian fiscal authority mandates that domestic suppliers and customers retain the fiscal documents for
government tax purposes. Companies are also required to retain fiscal documents so that fiscal authorities can review
applied taxes on the sale and purchase of goods and services.

Oracle Shipping integrates with fiscal document generation, which is part of Oracle Fusion Cloud Financials. Fiscal
document generation manages the generation and approval of fiscal documents by:

• Handling fiscal document requests from other systems

• Obtaining tax information from the tax system

• Submitting and managing fiscal document approval requests to the fiscal authority (government) system

• Communicating fiscal document approvals and rejections back to the requesting system

The fiscal document includes the relevant details of a sale, purchase, or transfer of goods between trading partners in
Brazil. The fiscal document has a unique ID number, identifies the parties, their locations, and the quantities of goods
being transported. Based on information derived from the shipment, you can request fiscal document generation for
the associated shipment. You can also monitor the fiscal document approval process, however, you can't ship confirm
the shipment until the fiscal document is approved.

Note:  Before processing fiscal documents, you must associate an inventory organization with a Brazilian business
unit. Shipping determines whether or not an organization is a Brazil organization by checking if the fiscal document
generation feature is enabled for a billing business unit. If this feature is enabled for an organization, it's implied that
the organization is a Brazil inventory organization.

Related Topics
• Brazil Outbound Shipment Flow

Brazil Outbound Shipment Flow  
The Brazil outbound shipment flow streamlines the process flow for fiscal document generation and approval for
shipments originating from inventory organizations based in Brazil.
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Oracle Shipping is integrated with fiscal document generation to process and monitor the fiscal document submission
and approval process. Fiscal document generation is part of Oracle Fusion Cloud Financials. This outbound shipment
process flow ensures compliance with Brazilian fiscal document processing requirements.

The Brazil outbound shipment flow is shown in the following figure.

Explanation of callouts:

1. The Brazil outbound shipment flow begins with the creation of a shipment.
The Brazil outbound shipment flow streamlines the process for fiscal document generation and approval
for shipments originating from your inventory organizations based in Brazil. Shipping integrates with fiscal
document generation to process and monitor your fiscal document submission and approval process.
The Brazil outbound shipment flow lets you process pick-to-order (PTO) kits and assemble-to-order
(ATO) models for sales order and transfer order shipments. For example, you can create a sales order for a
complex item structure, such as a hybrid model that contains both a PTO model and ATO model. Shipping
communicates the relevant information for fiscal document generation to ensure compliance with Brazilian
fiscal document processing requirements.

2. After the outbound shipment is staged, the action Request Fiscal Document is enabled for the shipment.
3. You can then request fiscal document generation by clicking the action Request Fiscal Document. (Recall fiscal

document generation manages the generation and approval of fiscal documents.)
4. After a fiscal document is approved, the fiscal document status associated with the shipment is updated to

Approved, and the action Ship Confirm is enabled for the shipment.
5. You can then confirm the shipment and print the fiscal document.

Shipping integrates with fiscal document generation to ensure compliance by generating and approving fiscal
documents. Fiscal document generation submits the fiscal document to the fiscal authority and receives the necessary
approvals. Fiscal document approval is communicated to Shipping, which enables users to proceed with the ship
confirm process. This process flow provides the necessary validations to ensure a shipment can't be processed without
an approved fiscal document.
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Note:  The Brazil outbound shipment flow supports only inventory transfer types Transfer Order Interorganization
Shipment and Return to Supplier. The following inventory transaction types aren't supported: Transfer Order
Interorganization Transfer, Transfer Order Return Shipment, and Transfer Order Intraorganization Transfer. Also,
interorganization transfers from the Create Interorganization page in Oracle Fusion Cloud Inventory Management
aren't supported.

Use the Manage Shipments page to manage fiscal documents for shipments originating from inventory organizations
based in Brazil.

Comparison of a Brazil Outbound Shipment Flow with a Regular Outbound
Shipment Flow
Several differences exist between a regular outbound shipment flow and a Brazil outbound shipment flow. The
fundamental difference is that outbound shipments originating from a Brazilian inventory organization require a fiscal
document, whereas a regular outbound shipment doesn't require a fiscal document.

Other differences include:

• You can't confirm the shipment until the fiscal document is approved by the fiscal authority.

• You can't edit the shipment while fiscal document approval is in process.

Additionally, the fiscal document serves as the bill of lading for shipments originating from Brazil, detailing the quantity
of items transported from the supplier to the customer.

Related Topics
• Overview of Brazil Outbound Shipment Fiscal Documents

• Interorganization Transfers

How You Manage Brazil Outbound Shipments  
Oracle Shipping provides a comprehensive process flow to ensure fiscal documents are generated for shipments
originating from inventory organizations based in Brazil.

Shipping users can request fiscal document generation from the Manage Shipments page. The job roles supported are:

• Warehouse manager

• Shipping manager

• Shipping agent

• Fiscal document specialist

Note:  The fiscal document specialist handles the fiscal document approval process within Oracle Fusion Cloud
Financials.
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The following actions are available on the Manage Shipments page for managing Brazil outbound shipment
transactions enabled for fiscal document generation:

• Request Fiscal Document. This action enables you to request generation of the fiscal document. To initiate
this action, the shipment must be in status staged.

Note:  You can request fiscal documents in bulk by selecting multiple shipments at once.

• View Fiscal Document Attributes. This action enables you to view attributes associated with the fiscal
document. However, you can initiate this action only after the fiscal document is approved.

These actions appear only if the business unit associated with the inventory organization is enabled for fiscal document
processing.

Shipping is integrated with fiscal document generation to process and monitor the fiscal document submission and
approval process. The outbound shipment process flow ensures compliance with Brazilian fiscal document processing
requirements. You have complete visibility and control of fiscal document processing.

The Manage Fiscal Document Generation page provides a consolidated view of all fiscal document-related
information. This page is owned by fiscal document generation, which is part of Oracle Financials. From this page, you
can monitor and review the status of your fiscal documents. Note that the transaction number represents the shipment
number. You can also perform various other actions, such as update fiscal attributes, generate fiscal document, and
print fiscal document. You navigate to this page by either clicking the task Manage Fiscal Document Status from the
Shipments work area or by clicking the action View Fiscal Document Attributes from the Manage Shipments page.

Related Topics
• Fiscal Document Shipping Statuses

• Fiscal Document Duty Job Role for Shipping Users

Tax Authority Requirements in Brazil  
You must set up Oracle Shipping to comply with tax authority requirements for sales oder shipments in Brazil.

Before you set up, consider these points:

• Should shipments be auto-ship confirmed at fiscal document approval? This determines how the shipment
should be confirmed when the fiscal document is approved. You need to decide if this should be a manual or an
automated process.

• How should Operations Fiscal Codes (CFOPs) be added to the shipment? Do you want to use rules set up in
Oracle Fusion Cloud Order Management to default CFOPs or enter them manually on the Manage Shipment
Lines page or in Oracle Order Management.

Automatically Ship Confirm at Fiscal Document Approval
If you want to automatically ship confirm at fiscal document approval, here's what you need to do:

1. In the Setup and Maintenance work area, go to the Manage Shipping Parameters Unit task:

◦ Offering: Manufacturing and Supply Chain Materials Management

◦ Functional Area: Shipping
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2. On the Manage Shipping Parameters page, select the Automatically ship confirm at fiscal document
approval check box, if you want a shipment to automatically ship confirm at fiscal document approval.

Note:  Ensure your outside processing item has a cost prior to generating a fiscal document. If the item has never
been transacted in the organization or the costing method is average, you will need to perform a miscellaneous
receipt before establishing the cost.

While generating reports The BI Subject area is Shipping Real Time Subject Area.

Use Fiscal Operation Codes in Transactions Originating from Brazil
Codigo Fiscal de Operacoes Mercantis e Prestacoes de Servico (CFOP) refers to operations fiscal codes defined by the
Brazilian tax authorities that describe the type of business transaction (for example, sales order, drop shipment, and
outside processing). They represent the fiscal classification related to the destination of the service or material involved
in a shipment. A CFOP contains information about the good's origin as well as the type of operation, such as sales,
returns, stock transfers, or services.

The ship from and ship to location combinations of the shipment are used to determine a CFOP. Shipping defaults
CFOPs from rules that are set up in Oracle Fusion Cloud Order Management, or you can enter them in the Shipping
pages, Manage Shipment Lines or Edit Shipment > Transaction Business Category field.

This table indicates the different business process flows supported for complying with tax authority requirements for
sales order shipments in Brazil and possible CFOP codes.

Flow Flow Type Where to get CFOP Code Possible CFOP Codes

Sales Order Shipment
 

Sale of purchased items
 

Sales order VIB rules
 

5101, 6101
 

Sales Order Shipment
 

Sale of OEM items
 

Sales order VIB rules
 

5102, 6102
 

Drop Shipment Supplier
 

Supplier-manufactured items
 

Entered in Shipping page
 

5118, 6118
 

Drop Shipment Supplier
 

Supplier-purchased items
 

Entered in Shipping page
 

5119, 6119
 

Drop Shipment Seller
 

Sale of purchased items
 

Sales order VIB rules
 

5120, 6120
 

Outside Processing
 

Movement of outside processing
supplier
 

Entered in Shipping page
 

5124, 6124
 

Consignment Return
 

Symbolic return of consigned
material
 

Original PO receipt
 

5919, 6919
 

Add Freight Costs and Charges to a Brazil Shipment
You can add freight costs and charges to a shipment for a Brazil organization.

When you add a freight cost or charge item to a sales order, the freight cost or charge applies to the entire shipment
regardless of the quantities shipped on the shipment lines.
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You have to set up a non-shippable inventory item in Oracle Product Information Data Management for the freight costs
and charges for a shipment. The item is entered on the order in Oracle Fusion Cloud Order Management with Product
Type as Goods.

Note:  Partial shipments can't include freight charges.

Fiscal Document Transaction Types  
An internal shipment for fiscal document transactions requires a shipment (and receipt) and a fiscal document.

The Brazil outbound shipment flow supports only in-transit interorganization transfers. Direct interorganization
transfers, intraorganization transfers, and return internal material transfers are not supported.

Related Topics
• Interorganization Transfers

Fiscal Document Shipping Statuses  
Use the fiscal document statuses to search for your fiscal documents in a specific status.

Fiscal document statuses available from the Manage Shipments page include: In process, Approved, and Canceled.

After you request fiscal document generation, the shipment is in status In process. Note that you can no longer update
the shipment. After the fiscal document is in status Approved, you can confirm the shipment. If the fiscal document is
canceled, you can close the shipment.

Related Topics
• How You Manage Brazil Outbound Shipments

Fiscal Document Duty Job Role for Shipping Users  
To access fiscal document generation-related tasks, you must have the duty job role Fiscal Document Generation Duty
assigned to you.

This duty role is not provisioned automatically. This role contains fiscal document processing entitlements, such as
Submit Transaction for Fiscal Document Generation, Manage Fiscal Attributes, and Print Fiscal Document. If you are
a warehouse manager, shipping manager, or shipping agent and want to perform fiscal document tasks, ask your
applications administrator to manually assign these roles to you.

Related Topics
• How You Manage Brazil Outbound Shipments
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